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ABOUT THE AUTHOR
A former photojournalist and reporter, Chris Nelson used to supplement his small-market wages shooting weddings,
advertising images, and senior portraits. In the process, he found that he enjoyed his sideline more than his day job.
In 1991, he quit his newspaper gig and started a portraiture business, which moved to Fall Creek, Wisconsin, a few
years later and became Fall Creek Portrait Design.

Since then, study within the photographic industry has influenced his development. He credits photographers
Monte Zucker, Don Blair, and Michele Gauger for the foundations of his photographic style. “Robert Lino and
(the late) Dean Collins have really influenced my glamour style,” he says, “and maybe a little of Herb Ritts, too.”

Chris Nelson is a graduate of the University of Wisconsin–Milwaukee who earned a B.A. in English (applied writ-
ing and journalism), plus minors in philosophy and fine-art photography. He has also earned his Accolades of pho-
tographic Mastery and Outstanding Photographic Achievement from WPPI (Wedding and Portrait Photographers
International). A number of his glamour images have earned merits in WPPI and PPA (Professional Photographers
of America) competitions, with one currently under consideration for print of the year.

Glamour photography now comprises about 20 percent of his studio’s business and is growing each year. “The
fun part has been learning how to make women look great. The hard part was learning how to build a classy and
artistic image of it,” he recalls. In writing this book, he hopes to help other photographers do just that. 
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T here are a few words I use to describe my style of glamour
photography: elegant, fashionable, alluring, sexy, glamorous,
sensual, attractive, playful, or just plain fun—all adjectives as in-

dividual as women’s personalities. A female client might also use any one of
these words to describe the portrait she’d like your help in creating for her.
That’s where the life of a commissioned glamour portrait begins—with what
the client wants. Understanding each client’s reasons for wanting that por-
trait is also an essential component of building a successful glamour photog-
raphy business.

In commissioned glamour portrait photography, your clients are the
women themselves, not a magazine, advertising firm, or modeling agency. In
fact, that’s the difference between this book and many others devoted to
glamour, boudoir, or fine-art figure photography. You’re not paying her to
pose; she’s paying you to produce an image that flatters her femininity. Often

the image will be a gift for her husband, boyfriend,
or fiancé, but just as often it’s for her. It supports
her image of herself as physically attractive. What’s
more, if you can make her look better than her per-

ception of herself, she’ll love you for it, she’ll pay you, and she’ll bring you
more clients.

To do this, you’ll need to develop three basic skills: a photographic style
that flatters feminine faces and figures, interpersonal skills to sensitively and
perceptively work with a female clientele, and a marketing plan that creates
a positive image of your work and your studio.

REASONS FOR COMMISSIONING A GLAMOUR PORTRAIT

Let’s look at a few examples that showcase the variety of needs your clients
may have when they come to your studio for glamour portraits. As you’ll
see, they are all individual.

A Special Hobby. Veronica’s fiancé is a motorcycle enthusiast and so is
Veronica (next page)—at least she likes to ride with him. She wanted to pose
in leather with a Harley-Davidson. She didn’t think she could get the bike to
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1. THE GLAMOUR PORTRAIT

You’re not paying her to pose; she’s paying you 
to produce an image that flatters her femininity.

 



the studio without him knowing it, but said he loved vintage bikes and I
happen to own one. 

For the image, Veronica dressed in motorcycle boots, tight leather pants,
and a black satin bra. I posed her in profile with her face turned upward. I lit
her as a semi-silhouette and added flames in the foreground—a little trick
with lighter fluid I learned in pre-digital days doing theater props in college.
It’s one very sexy image, and she and her fiancé bought a large framed print
to display behind their bar.

Fitness Portfolio. Tonya (facing page) wanted a portfolio of images for
an upcoming fitness competition. A “thirty-something” victim of down-
sizing, she had more time than usual to spend at the gym. There, a trainer
noticed her physique and suggested she compete. Hesitantly, she entered a
local competition and won. Then she won another, qualifying her for a re-
gional event; if she placed in the top three, it would allow her to turn pro. 

In planning her session, we decided that images taken at a local waterfall
would provide a good setting for showing off her physique. Shooting dur-
ing the day’s last golden hour would also emphasize her tanned skin tone. We
used three outfits: a white posing bikini, a black posing bikini, and a pair of
cutoff shorts with a white button-down blouse tied up under her bustline. 

Toward the end of the session, we posed her in the water for a few “wet
look” shots. Tonya’s proud of her body and thought she’d like to have a few
nudes—provided that the focus was on her physique and not sexually
graphic. We posed her in and out of the water, taking care not to sexualize
the images too much and concentrate, instead, on her physique. She loved
the images—so much so that she put one copy in her contest portfolio and
made another “teaser” for her husband. “Is he why you wanted this image?”
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In commissioned glamour portraits, your
clients often come to the studio with some
ideas of their own. Here, Veronica wanted a
portrait for her motorcycle-loving fiancé. 

FACING PAGE—Tonya came to the studio for im-
ages to use in her portfolio for an upcoming fit-
ness competition. During the shoot, however,
she also decided to do some tasteful nude im-
ages, which she (and her husband!) both ended
up loving.





I asked. “Well, yes,” she said, “but mostly it’s because of how much I’m
going to like it when I’m seventy.”

A Racy Wedding Gift. Barb (above) came to the studio for her bridal
session with her friend and maid of honor, Pam, who provided moral support
and helped with her dress. We did a great set of bridal images, both tradi-
tional and more fashion-oriented. Barb then went into the dressing room to
change. A minute later, however, Pam came back out. “Barb wants to do
something racy, to give to Eric as a wedding gift,” she said. 

We did a number of poses in her white bridal lingerie—a bustier, garter
belt, and white stockings—however, her choice for his gift was basically a
nude. Shot from straight above, Barb laid face up on the train of her dress.
We draped her cathedral-length veil over her otherwise naked body to soften
the lines of her body and partially conceal it. She was so proud of the image
that she brought her mother in to see it before we printed it! Barb and I de-
signed an album with her favorite images and we made a wall portrait of the
image described above for her bedroom.

A Group Session. Fawn, Laura, and Jennifer decided that a glamour ses-
sion would be fun for a group birthday celebration. The trio was after a fash-
ionably sexy look with little black dresses, lacy tops, and a little lingerie
(facing page, left and bottom).

While they each wanted appealing shots individually, they all wanted a
really “hot” image of the three of them together (facing page, top right).
They wanted the portrait for themselves, but they also wanted one for each
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This bride came to the studio for wedding por-
traits, but then decided that she also wanted 
to create a very special wedding gift for her
husband-to-be.
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BELOW AND BOTTOM (LEFT AND RIGHT)—These
portraits have just the fashionably sexy look
the friends were looking for. RIGHT—In addi-
tion to individual portraits, the women also
wanted a “hot” group portrait.



of their husbands. Covering their bare breasts Victoria’s Secret style, each of
them stood defiantly in matching calf-high boots and red-and-black boy
shorts. “It’ll shock them, but they’ll love it,” Jennifer joked.

All three bought session books, a small album containing an entire set of
images from their session. In addition, we made three posters of their fa-
vorite image of the three of them together—one for each husband.

It just goes to show you, anyone—Veronica, Tonya, Barb, or Fawn and
her friends—could be a potential glamour client. All of these women had a
different reason for doing a glamour session. As a result, the final presenta-
tion of their images was also different—large portraits, session books, port-
folios, and glamour albums. Yet each woman had a similar goal: to create an
image that portrayed her femininity. They all wanted to be attractive, allur-
ing, and sexy—and they all were happy to pay for it.

SO WHAT IS A GLAMOUR PORTRAIT?

“We all want to look sexy and beautiful,” says glamour-portrait client 
Tarina, “but not trashy.” There it is; if your goal is to add glamour portrai-
ture to your studio’s offerings, you need to understand this critical principal.
As a glamour photographer, your goal is not to stroke male fantasies (al-
though you’ll undoubtedly do that indirectly) but to help create your female
clients’ vision of what it means to her to be attractive and sexy—and that vi-
sion is almost never tawdry or pornographic. 

That’s why my studio calls our images glamour portraits rather than
boudoir images. We made that decision after discovering that many of our
clients found the word “boudoir” kind of scary,
and the connotation . . . well, on the pornographic
side. In actuality there may be no difference be-
tween a glamour and a boudoir image, but clients
perceive boudoir images to be about sex for the sake of sex. If an image is
considered glamorous, however, its goal is perceived as the depiction of the
subject’s beauty, not her sexuality. It makes a big difference.

As a photographic genre, glamour is also more open. It can include im-
ages that go far beyond what falls into the boudoir category. Depending on
your client, glamour might include fashion-inspired headshots like you see in
magazines, curvaceous poses with the subject in a tight black dress, seduc-
tive images with lacy lingerie, etc. And if, to another woman, “glamour”
means lying naked under a waterfall with water splashing over her, that works
too.

THE BEAUTY IN EVERY SUBJECT

When you create a glamour portrait, you are actually helping your subject see
her own beauty and strengthen her self-image. “I can’t believe that’s me,”
Krystal said as I displayed her image on my camera’s LCD. “That’s not what
I see when I look into the mirror.” That’s because, like many women, she was
concentrating on what she perceived as her flaws. 

10 MASTER GUIDE FOR GLAMOUR PHOTOGRAPHY

When you create a glamour portrait, you are 
actually helping your subject see her own beauty.



Women are usually their own toughest critics. What I do as a photogra-
pher is to turn that around. I believe there is beauty in every client. I know
that sounds cliché, but it’s true—and it’s not even that hard to find if you
adopt the right mind-set. Not every woman is a potential Victoria’s Secret
model, and you don’t need to try to make your subject look like one. Instead,
you should set as your goal exceeding the perception she has of herself when
she looks into the mirror. 

SIX STYLES

My goal is to understand my subject’s unique perception of herself and turn
it into a look for her portraits. In my mind, I’ve categorized these looks into
six styles. Most of the time there’s some overlap between styles, but the men-
tal framework is really useful for you and your client—especially when it
comes to determining what kind of look she wants.

Classic Beauty. If the reaction to your image is, “Wow, she’s beautiful,”
this image fits into the classic beauty style. Classic beauty images can be any-
thing from headshots to full-length portraits and will be unmistakably fem-
inine with a degree of elegance, as well. First and foremost, the image is
beautiful; any sexuality is subtly implied. 

Classic beauty images can be created with 
the subject fully clothed or completely nude.
What makes them “beauty” images is the em-
phasis on the subject’s femininity rather than
her sexuality.

 



Keep in mind that the choice of clothing doesn’t determine this. The
subject could be fully clothed or nude. If it’s a full-length image, a beauty
shot could be posed and lit to show off an hourglass figure (usually short lit
to emphasize the roundness of the subject’s breasts and hips with the head
tipped toward her high shoulder). If the image is a head-and-shoulders shot,
the head is usually tipped to the high shoulder, emphasizing the eyes, lips, fa-
cial structure, and hair.

12 MASTER GUIDE FOR GLAMOUR PHOTOGRAPHY

TOP LEFT—Beauty headshots typically show-
case the subject’s eyes, lips, facial structure,
and hair. ABOVE AND LEFT—Even in more re-
vealing garb, beauty images communicate a
sense of elegance.



Fashion. Think magazines here—anything you might see in a cosmetics,
jewelry, or clothing advertisement or editorial feature. This is one our clients’
most popular looks because it’s what they see all around them in the media.
Often, women even bring in magazine clippings and ask us to create some-
thing similar. 

Regardless of cropping (from headshots to full-length portraits), these
images are usually fashion lit, meaning you will use a large main light with
butterfly or broad lighting. Since the models seen in magazines and catalogs
are usually clothed, so are your subjects when they pose for this look.
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High key lighting and backgrounds are often
used in fashion portraits. This is great, because
white seamless sweeps are inexpensive and
available to any photographer.

Fashion headshots, like this butterfly-lit image
of Shelly, can be really dramatic. Covering one
eye with her hair makes the other that much
more powerful. It also draws attention to her
gorgeous hair. Selective color was added as a
finishing touch. I loved this headshot so much
that I entered it in print competition where it
earned merits from both PPA and WPPI.

 



Artistic. Think “abstract” when describing this look. These are images
like you might see in an art gallery—and a lot of women would like to see
themselves there. Unlike any other style, form—not faces—usually domi-
nates in this style (in fact, you’ll notice that none of these portraits even in-
clude eye contact). As a result, you can leave traditional portrait-lighting
techniques behind and feel free to experiment. Look to famous painters,
sculptors, and graphic designers for inspiration. If a client is willing, I usually
try to include at least a couple images of this style in each session.

Pin-up. When you think of a pin-up girl, you think of sexy and cute. The
goal of a pin-up image is to tease and titillate. With these images, the sub-
ject’s expression and body language make the image. Your photographic
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TOP LEFT—For this image of Carissa,
we wanted an overall high-key look
with her body (in particular her long
legs and her blond hair) as the only
accent colors. TOP CENTER—Athena is
actually a musician, so we wanted an
attention-getting image. Her favorite
color is purple, and since it compli-
mented her skin tone, we used it for a
background. She’s fond of saying she
goes about life backwards, so we
posed her upside down. It’s great that
you don’t notice the nudity first.
That’s why we did it. TOP RIGHT AND
BOTTOM LEFT—In artistic portraits,
it’s not uncommon for the subject’s
face not to be seen at all. This lets the
viewer connect more directly with the
mood of the portrait, rather than the
look of the individual subject.



technique will also be used to support and accentuate the usually playful,
fun, and sexy message. Because body language is so important, pin-up poses
are almost always full- or three-quarter-length. 

ABOVE—Jessica chose her summer job as a
theme for her pin-up. “A lot of guys at [my
beach] would like this one,” Jessica said, look-
ing over the images from her session. There is
no mistaking that Jessica is a lifeguard. All we
needed was sunshine, a couple well-chosen
props, and the right setting. RIGHT—“This will
really shock him,” said Bethany, “I can’t wait
to see his face.” Homemade bikinis can be
great teases, and Bethany really pulled it off
with the caution tape. We came up with the
idea during her consultation. The tape was
something her fiancé used to restrict construc-
tion zones at work . . . and he’ll probably never
look at it quite the same after seeing this shot!

 



Sensual. What is sensual? Applied to an image, it is overwhelming the
senses (in this case, the eyes) with a vision of a desirable body. It is a volup-
tuousness of the mind, taking pleasure from the body and, at the same time,
freeing the spirit from its bounds. There you have it: amateur psychology
and metaphysical postulation from the author.

But if you look at several examples, the description fits the images pretty
well. Brooke’s mind is in a peaceful, pleasurable place with her body follow-
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Sensual images, like these of Morgan (above)
and Brooke (left), typically impart a dreamy,
veiled lustfulness.



ing its lead (facing page, bottom). Morgan’s dreamy longing is instantly un-
derstood by anyone viewing this image (facing page, top).

Sensual images need to impart a dreamy, veiled lustfulness—a kind of
blissful surrender. For this reason, subjects are often posed reclining with
their eyes closed or not making direct eye contact with the camera. This con-
veys a blissful, carefree, disconnectedness from the everyday world; the sub-
ject is absorbed in the pleasure of escape. It’s a place we’d all like to be.
Creating an image that helps us get there, if only for a while, can have
tremendous value.

Provocative. This category almost doesn’t need an explanation. These
images may look assertive or playful, but they virtually demand to be looked

The playful expression on Tonya’s face, com-
bined with soft lighting and a pastel back-
ground, invites you into the image rather than
projecting an in-your-face attitude.

 



at. For this reason, the subjects make direct eye contact with the camera—
and not demurely, but with confidence. 

While there are no clear-cut lines—many images could correctly be placed
in more than one style—the structure these categories create is helpful in
several ways. First, categorizing images helps you develop a mental frame-
work for your work and, therefore, helps you create images. Second, divid-
ing the images into these categories helps each client decide which style she
prefers. Third, it will help you talk to your client clearly about the kind of im-
ages she wants. If you prepare a slide show or portfolio of images and cate-
gorize them according to these styles, it will give you a common language for
discussing images, planning her session, and ultimately giving her exactly
what she wants.
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LEFT—Collette’s image is the ultimate invita-
tion. We used a single large softbox to light
her evenly. The image was made as an anniver-
sary gift for her husband. The inspiration for
the pose was a Playboy centerfold her husband
liked and had displayed on his machine-shop
wall for quite a while. To surprise him, she re-
placed the centerfold with her image and
waited for his reaction. RIGHT—Notice the con-
fidence exuded in Athena’s pose. We chose the
leather pants for their fit and balanced them
with a high-key background.



I t took me a few years to realize that a glamour session is not
only an image booster, it also provides a safe venue—and I can’t
emphasize safe strongly enough—for your client to explore her

sexy, sensual side. By “safe,” I mean that the client must feel no sexual pres-
sure or have any worry whatsoever that some of the more intimate images
you create will turn up anywhere that might prove embarrassing to her. “I
think this is so sexy,” Rita said holding a very sheer, tight, charcoal top. “I
bought it because I loved it and I think I look really good in it. But on the
way home, I thought, ‘Where the heck am I going to wear this?’” My stu-
dio was it—and when you think about it, there aren’t that many places.

It’s really important that each subject realizes it’s your job to make her
look good. Most of us have had our share of unflattering photos, so most
people are a little apprehensive in front of the camera to begin with. In a
more intimate situation, your client will feel even more vulnerable, so reas-
surance is critical. Your LCD is a valuable tool here, especially early in the ses-
sion. Simply turning the camera around and showing your subject how good
she looks can really put her mind at ease.

THE PLANNING CONSULTATION

A planning consultation is a must—not only because the focus of the session
needs planning but also to get acquainted with the client, since you may be
working with her on a fairly intimate level. At my studio, before the consul-
tation, the client and I will usually have already had at least one phone con-
versation. In most cases, she will also have seen some of my work at displays
or on my web site. When a client like this books a consultation, she’ll already
have respect for your work. Yet, the initial face-to-face meeting is still im-
portant; it’s your chance to strengthen that impression and to begin to un-
derstand her personality.

I suggest beginning the consultation by showing the client a slide show
of your work. This serves several purposes. It gives her another chance to
gauge your work, and seeing what other women have done often stimulates
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2. UNDERSTANDING YOUR CLIENTS

The LCD screen on your digital camera is a
great tool for putting your subject at ease.
Once she knows how great she looks, she’ll be
much less nervous.

 



ideas of her own. On the flip side, her reactions to the images will give you
some insight into her tastes photographically. As discussed in the previous
chapter, it helps to organize your slide show into the six glamour categories
described so you’ll have a common point of reference when talking about
what she likes. 

SELF-RATING QUESTIONNAIRE

One technique I find particularly valuable is a short questionnaire that asks
the subject to rate herself and her appearance. This helps you as the photog-
rapher determine what physical attributes she’s proud of and which ones
she’s a little apprehensive about. Women are usually more critical of them-
selves than other people.

The questionnaire I use is a pretty form asking her what she likes about
her appearance and what she doesn’t. It also asks her what she’d like to im-
prove if she could. You get some pretty frank, sometimes humorous and
often surprising answers, but it tells you what features to focus on and what
you should try to hide in order to create a portrait she’ll love. 

When it comes to problem areas, I can almost guarantee your clients will
list one or more of the following: stomach, breasts, hips, upper arms, and
nose. Of course, any one of these could just as easily be assets she’s proud of.
If you can turn any of her perceived negatives into positives, you’ll really im-
press her and probably increase your potential sale as well. 
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A well-organized, thoughtful consultation is
the key to determining how to create an image
that will truly thrill your subject.

 



THE PRODUCT SHE WANTS

Once you’ve created the images, what will you make with them? What does
your subject want to take home with her? A big part of our consultation con-
sists of presenting the different options clients have for a final image presen-
tation. With the evolution of digital imaging, that range of options is really
growing. 

Calendars. We have two types. The first is a twelve-month flip calendar,
which is one of the more involved pieces we do, both in terms of the pho-
tography and the graphic design. These are really cool gifts, and we’ve had
a lot of women pose for and buy them for boyfriends, husbands, and fiancés.

Knowing what a woman loves about her ap-
pearance—as well as what she’s not so crazy
about—will help you sculpt a shot that makes
her feel great.



Our calendars are printed on 10x15-inch sheets of photographic paper. Typ-
ically, each page includes a feature image and one or two supporting ones.
There is one page per month, and her favorite image (or two) is used for the
cover.

Variety is the key to success; calendars demand at least eight different
themes so they won’t be repetitive. Because of that, we need to go into the
photo shoot knowing that we’re making a calendar. 

The second type of calendar is a calendar poster, which we print on a
16x20-inch or larger canvas. Normally, this features a favorite image sur-
rounded by the calendar pads for twelve months. Because any dramatic image
can be used, we can decide after reviewing her images that we’d like to make
one of these. 

Our staff and I have made horizontal, square, and vertical templates for
these calendars—and that’s the hardest part of creating these posters. Once
the templates are done, you can simply drag and drop your image, add a lit-
tle type, and you’re done. Since they feature one large image and require lit-
tle time in production, these are one of our more profitable products. 

Because calendar posters are usually prominently displayed, women will
usually pick a dramatic but appropriately clothed image. Be happy when one
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Flip calendars feature one page for each
month. Typically, each page includes a feature
image and one or two supporting ones. 



goes out your door, because the advertising and referral value is huge.
They’re large and dramatic and they demand attention. 

Since I started making these a few years ago, I found that men often buy
calendar posters, too. “I saw that 2006 poster you had in your mall display,”
said Shelly’s boyfriend, as he held a 4x6-inch image from her session book.
“I’d like to make a calendar like that with this [image].” Shelly said she was
a little embarrassed when he first put it up, but later told me it was a real ego
boost. 

Centerfold Posters. What’s in a name? Well, this one has a very sexy
connotation—no wonder centerfold posters are our number-one seller for
Valentine’s Day gifts. Relatively inexpensive and a real attention getter, we
usually print these as a 10x20-inch photographic print, which is very close to
the size of a Playboy, Maxim, or FHM foldout centerfold—something the
guys who usually receive these images will be familiar with!
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Calendar posters, which we print on a 16x20-
inch or larger canvas, feature a favorite image
surrounded by the calendar pads for twelve
months. 



The word “centerfold” has a very
sexy connotation. Jenny took that to
heart—and caused mine to miss a
couple beats—with this pose. “My
husband always looks at Playboys and
I’ve told him I look as good as any of
those girls,” she said. “He didn’t be-
lieve me, but I bet he will when he
sees this.”



Session Books. A session book is just that, a small book containing all
the unique images from a photo session. An individualized glamour session
is probably not something most women do that often, so the book is the
perfect keepsake. As long as it’s fairly affordable, it’s an easy sell. They’re 
the number-one sale from my glamour sessions—and a lot of other portrait
sessions, too.

The sale is easy, because I project slide shows (I call them “screenings”)
immediately after a session. By the time my client is done changing, we’ve got
the images loaded into the computer with some rudimentary cropping and
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Tonya’s and Teresa’s posters are multi-image
constructions. Teresa (top) loves her Mustang
convertible, a gift from her husband. It makes
her feel sexy and fun, so naturally we wanted to
use it as a prop. Framed, the poster is dis-
played proudly in her husband’s office. Tonya’s
poster (bottom) is for herself first, although her
husband Bob enjoys it, too. At thirty-seven,
Tonya enjoys competing in fitness competitions.
“This is probably the best I’ve ever looked,”
Tonya said. “I want to remember it when I’m
seventy.”

 



color correction and into a program for a slide show. (Note: For this process,
it really saves time to get your cropping and white balance as close as possi-
ble in the camera.) 

We need something to talk about during her session, so I always make it
a point to find out what kind of music she likes. Our studio has a fairly ex-
tensive music library, so we set the show to music she likes and project it 
on a 9-foot screen. With the excitement of the session still fresh, the slide
show can be overwhelming—especially if you’ve made her look better than
she expected. 

“Which style session book do you prefer?” I’ll ask. It’s sales phraseology,
a “choice” question versus a “yes or no” question. The session’s impact is
often so powerful the sale is pretty much automatic—she wants it. Even
though she may have done the session to make a gift for a significant other,
most women purchase the book as a keepsake for themselves.

My studio offers two types of session books: a photographic style and a
printed style (isn’t digital technology beautiful?). The photographic books
have fixed mats and hold one image per side, two to a spread. The printed
styles are produced on a digital offset press and come in horizontal or verti-
cal formats and in a variety of sizes. My favorite has a glossy book cover that
we can design using her favorite images.

Designer Albums. Designer albums are the most complex presentation
offered at my studio. The albums have leather covers and feature flush-
mounted pages that showcase some or our best work using Photoshop,
Painter, and other graphic-design programs.

After reviewing a clients’ images, together we pick the images for the
album and determine which images will go on what pages. Next, I (or my
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ABOVE—One of my favorite types of session
books has a glossy cover that we design using
the subject’s favorite images. FACING PAGE—
Brooke is a singer for a regional rock act, a
real beauty and free spirit. The examples are
some of her favorite pages. 





graphic designer, Ashley) go to work laying out the album. The client is then
presented with a proof of her layout on CD. After her approval, we print the
pages and have the album bound. 

Again, a planning consultation goes a long way toward establishing a
comfort level with your clients. Not only does it help them understand your
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Jennifer was a calendar girl appearing in a
local rock station’s 2005 calendar. The hard
choice for us was that we could only use two
images for the calendar. Jennifer and I hit it
off and our session went well beyond what was
needed for her calendar feature. Of course, she
wanted to have a keepsake of her session. The
two pages selected will give you a feel for the
album.



approach to photographing each session, it also tells you what styles of pho-
tography she likes and what she doesn’t. That, along with an overview of
final product options, saves you both a lot of potentially wasted time and
helps you do a better job for her. 

STUDIO ATMOSPHERE

Studio atmosphere goes a long way toward making a client comfortable. It
doesn’t matter what style you choose, so long as it has a rich, comfortable,
and consistent look. Of course, if it looks expensive, chances are your clients
will also come in expecting to spend a little more money on your services.

This candid pose of Tarina (top left) was taken
as she prepared for her bridal session. It shows
the look of the main dressing room. I some-
times use the dressing room as a background,
as in this sassy pose of Kristal (bottom left)
and this coy portrait of Bridget (right). In both
cases, I used the uncorrected tungsten light in
the background to set the mood in each image.
Daylight-balanced strobe was used to light the
subjects, producing a flattering skin tone.



My studio, at least a portion of the building, was originally a bank built
in the 1880s. We went to a lot of time and expense to restore the ceilings
(two of which retain their original stamped-tin ceilings) and the woodwork
to their original 19th-century look. We then chose furniture and light fixtures
to complement the style.

Dressing Room. In addition to the comfort factors I’ve already men-
tioned, privacy is one that can’t be omitted. During her session, the dressing
room should be her space. The look and feel of the space is also critical.

“I just love the ceilings in [your studio]. I wish I could have these in my
home,” Veronica said as we showed her into her dressing room. It’s no ac-
cident that the dressing room is one of the two rooms in my studio with a
stamped-tin ceiling (the other, larger one is my camera room). This room al-
ways makes an impression and makes my clients feel pampered. 

The second dressing room is a little different, with an early 20th-century
look and a wooden floor. In addition to being a very welcoming place for our
clients, it’s a great spot for portraiture. On two
walls, there is rich wallpaper in earthy browns and
greens and an ornate pattern, the other two walls
are exposed brick. A few framed photographic im-
ages in complementary colors hang opposite oak wall hooks for hanging
clothes. A makeup table with a stool sits under an ornately framed mirror, il-
luminated by two downward-turned antique brass wall sconces. Opposite
the table is a dark-green Queen Anne style loveseat. In addition to the lights
above the mirror, there is a small lamp below a ceiling fan and some rope
light wound around the outside of what used to be an exterior window. I
just frosted the glass to allow light in while maintaining privacy. All the lights
in both dressing rooms are tungsten, creating a warm glow in the images
taken there. On the previous page I included a few examples of images taken
in the main dressing room. 

HAIR AND MAKEUP

Hair and makeup can make or break your session. Some women are profi-
cient doing their own; others will bring friends to help. If your studio offers
hairstyling and/or professional makeup services, you’ll make your clients feel
even more pampered. My studio does this in several ways. Let’s take makeup
first.

Both my dressing rooms are stocked with a good selection of makeup—
foundation, lipstick (in a wide variety of colors), eyeshadows, eyeliner, and
mascara. Although many women will prefer to use their own products, it’s
there if they need it. In addition, we always keep lotion and hairspray in stock. 

My assistant Ashley does a great job assisting with both hair and makeup
as needed. I rarely apply makeup myself, but I’ve learned enough about how
it’s done to direct my clients or their assistants on how to get the look they
want. If you need to educate yourself, there are a number of good books on
the market that can be very helpful. One of the best I’ve seen is Making Faces
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In addition to the comfort factors I’ve already 
mentioned, privacy is one that can’t be omitted. 



by Kevyn Aucoin (Little, Brown and Company, 1999). I keep a copy in my
dressing room for my own reference. It breaks down the different looks and
provides step-by-step instructions, so it’s easy for clients to follow, as well.

I also have developed relationships with several hairstylists and makeup
artists to whom I often refer clients. (It’s pretty easy for a client to stop by a
salon on the way to her photo session.) Getting to know these stylists has re-
ally educated me, particularly on the use of makeup, and the relationship
benefits both of us because we refer clients to each other. A great way to win
over a stylist or artist is to do a free session for her and offer to hang a gor-
geous portrait of her in her studio. Clients will undoubtedly ask her where
the great image of her was done, and that just opens the door!

CLOTHING AND ACCESSORIES

For the most part, my clients wear their own clothes, not garments from the
studio’s collection. However, it does pay to keep a few things around to fill
in the gaps. 

Feather Boas. Feather boas are classic glamour props and you should
own at least a half dozen of them in different colors, so that if you can’t
match a woman’s outfit, you can complement it. Boas are also useful in
strategically covering up problem areas or, as in Tonya’s case (next page),
thinly and provocatively covering the subject’s nudity.
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Hair and makeup can make or break your ses-
sion. Some women are proficient at doing their
own. Alternately, you can recommend a stylist
to really pamper them—either in the studio or
in a salon on their way to the session.



Fabric. If it isn’t already, the fabric store should become your friend.
Your imagination is the limit, here; fabrics of various colors and textures can
be used very effectively for backdrops, improvised drapes across the subject’s
body, and much more. For glamour props, it’s hard to beat the soft look of
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ABOVE LEFT AND RIGHT—Feather boas are clas-
sic props for glamour photography and can be
used to create a provocative nude portrait.
LEFT—This simple but provocative portrait of
Morgan used nothing but a piece of red satin as
a background. 



tulle fabric. It’s cheap, so make sure to have white, black, red, blue, green,
and purple on hand. The same goes for chiffon.

Clothing. I don’t stock a lot of clothing because it’s usually a very per-
sonal choice for the subject. There are a few things I keep on hand, though.
A few years ago, my sister-in-law found some faux leather pants at a sidewalk

RIGHT—White bridal tulle, like that in her veil,
is all it takes for this gorgeous bridal portrait
of Christa. BELOW—Melanie’s military look
uses a length of camouflage fleece to comple-
ment her outfit.



sale. She showed them to me and I bought four pairs (sizes 5, 7, 9, and 12).
We’ve used them a lot. They came in handy, for example, when Ivy wanted
to pose with a motorcycle (above). Leather and bikes are a natural combina-
tion, and she didn’t have any leather garments with her.

Fur coats are out of style, since animals have to be sacrificed. Still, they
are pretty sexy. In the past few years, I’ve found a number of inexpensive fur
pieces at resale shops. In the image to the right, Denise models a muskrat
coat found at a resale shop for $30. Vintage leather ones also work well and
are inexpensive. Many pawn shops have a nice selection. 

A few classically styled pairs of high heels in a variety of sizes are really
handy to own and can be found at resale shops, too. If you’re not sure what
to buy, take along a female friend with good taste.

Also included in my wardrobe assortment are gauzy white and ivory cot-
ton skirts with elastic waist bands, a floor-length black chiffon wrap, and an
assortment of dressy women’s hats—again from resale shops.

LINGERIE, SEMINUDES, AND NUDITY

My assistant Kelli and I put the finishing touches on the set—the nearly white
muslin backdrop set perpendicular to the large south-facing window, the vase
of pampas grass nestled into the corner, the small draped table with its
dresser-sized mirror, and the white chair next to it. 

The set took a while to prepare, and I had expected Athena to be ready.
After all, her outfit was pretty simple and she and Kelli had her hair and
makeup done. But the dressing room door was still closed. I knocked on the
door and told Athena we were ready for her, and she said she’d be right out.
Still, the door stayed closed, so I fiddled with the reflectors we’d use for the
window-light set.

Then, rather slowly, the door opened and out stepped Athena, not in the
white lingerie we had talked about, but clad in nothing but white leggings.
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LEFT—Leather pants are a natural for a mo-
torcycle shot, but not something every subject
would think to bring to her glamour session.
RIGHT—Fur coats are out of style, but they con-
vey a certain classic sexiness when used in a
glamour portrait.



My head pounded as I felt my blood pressure surge. “I thought about this
for awhile,” she said, “and I compete with a lot of magazines . . .”

“Wow, Athena, you really look good naked,” I said in a hesitating, choppy
sentence. I was flushed, flustered, and thankful Kelli was with me—but it
was the right thing to say. “I’ve told [my husband] that I look as good as any
of those girls,” she said, “but I don’t want to look sleazy.”

The session went well. Not sure how to handle the session and being
pretty flustered, I remembered a 200-level art class I took in college where
we sketched, drew, and painted nude models. I posed her how I remembered
our instructor posing our models—classical figure studies, she called them.

Athena looked great. She was a beautiful woman, clothed or not. Later
we switched to a background that better complemented her skin tones and

Being naked or very scantily clad can make
anyone feel vulnerable—all the more so when
a camera is present. By providing positive
feedback and assuring your subject that she
looks beautiful (not sleazy), you can help set
her mind at ease.



lost the bright white leggings. Most of the poses were classic nudes, like I’d
learned in art class. In a few poses we used a small swatch of white chiffon to
keep a little too much flesh from showing—I remembered what she said
about the magazine.

A Self-Image Booster. The experience was really valuable for me. It
helped me understand that some women like and are proud of how they look
either naked or without much on,
and there aren’t many outlets for
them to get undressed without sex-
ual pressure. By doing glamour ses-
sions, I provided just such an outlet.

“If I thought I looked this good,
I’d walk around naked all the time,”
Kristal said, half joking as we watched
her slide show. “This isn’t what I see
in the mirror after I get out of the
shower.”

Both Athena and Kristal were
thrilled with their images and, in
both sessions, a good percentage of
their images were nudes. For some
people, psychologically, a glamour
session is a real self-esteem booster—
as it was for these two. But, as Athena
said, there’s beautiful, artistic nudity
and sleazy, demeaning nudity, and
you have to differentiate the two
when talking to the women you’re
photographing.

“When you think about posing
nude, you hesitate,” said Janilee.
“You think ‘Oh my God, I’m in [a
sleazy men’s magazine].’ But when I
saw your slide show, I didn’t have to
worry about it.”

Not all the women you work with
will want to pose nude—in fact, most
won’t. I chose these examples be-
cause nudity represents the most sen-
sitive situation for both the photographer and client. But the same principles
apply with partial nudity, lingerie, or other revealing clothes.

Ask her how much she’s comfortable wearing or not wearing. Ask at her
consultation. Then ask again before you begin your session. Don’t hint at it.
Be direct but polite. And don’t worry if she changes her mind. She’s in an
intimate and vulnerable situation.
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Talking with your client about what she’s com-
fortable wearing is critical—both before the
shoot and at the start of the session itself.

 



Have Her Bring a Friend. To make her more comfortable, encourage
her to bring a trusted female friend. Bringing a boyfriend, fiancé, or husband
is usually too intimidating. She’ll worry about his expectations and not open
up. Her female friend will be probably be just the opposite—encouraging
and positively critiquing her. This helps you in two ways. First, it protects
you from any hint of impropriety. Second, if her friend is impressed with you
and has fun at her girlfriend’s session, chances are good that she will also be-
come your client.

Touching the Subject. Often I’ve been advised never to touch a nude
or scantily clothed client. I wouldn’t go that far. I do touch even nude clients,
but we’re fairly sophisticated in the way we interpret a touch. Just be sure that
you never touch a woman in a way she would interpret as a sexual advance.
Ask if it’s okay to adjust her hair, for example. 

Personalities are different, so you need to learn to judge which women
would be intimidated or take offense at a touch or a comment. Then, act ac-

cordingly. I always keep robes available in the
dressing room, and most women will use them.
Just as often, however, women will change right in
front of me and not even think about it (or maybe

they get a kick out of knowing they can show off a little without any sexual
pressure). 

Conversation. The same goes for conversation. Since you’re working
with women in a sensitive, vulnerable situation, you need to be judicious
about what you say—and it’s best to err on the conservative side. Some con-
versations, particularly when your client has a girlfriend along, can get pretty
descriptive and colorful. However, personalities are different. Where one per-
son might take offense at a comment, another will think it’s funny. 

Again, this comfort level is something you can begin to determine at the
consultation. It’s one reason, in my mind, why the consultation is an ab-
solute must. 
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Where one person might take offense 
at a comment, another will think it’s funny. 

 



M aking your client look her best is a sincere form of
flattery. And I always go by the “face first” rule:
there’s nothing more important to her than her pretty

face. To quote the late Dean Collins, “People, especially women, like two
things: they like to hear their name and they like to see their faces looking
thin.” Remember that, especially the last two words. And to make faces thin,
remember two more words: short light (sometimes called narrow light).

ANGLE OF MAIN LIGHT TO SUBJECT

When discussing lighting, we begin with the main light. Where this is posi-
tioned in relation to the subject will determine to a great degree the mood
of the portrait and how your subject is represented. 

Short Lighting. Short lighting means posing your subject and position-
ing your lights so that the shadowed side of her face is closer to the camera
than the highlight side. 

Broad Lighting. The opposite of short light is broad light. Quite sim-
ply, broad lighting means posing and lighting your subject so the highlight
side of her face is toward the camera. This can be quite beautiful. In fact,
you’ll see it in a lot of old advertisements, particularly from 1900 to the
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3. FLATTERING FACES AND FIGURES

SHORT LIGHT BROAD LIGHT FASHION LIGHT SPLIT LIGHT

Here, you can see the position of the main light
when creating the major lighting setups.



1940s. You need to be careful when using broad lighting on heavier subjects
or those with rounder faces. 

Fashion Lighting. A popular and commonly seen variation on broad
lighting is called fashion lighting, which could be also be described as flat,
large light source, front lighting. Once you hear that description, it’s pretty
easy to envision how you might do it. 

Use fashion lighting anytime you want to get a fashion-magazine or Vic-
toria’s Secret look in your images—but be sure to have the subject’s makeup
well done. In the portrait world, we get a three-dimensional quality in our
images by using light and shadow. In the fashion world, on the other hand,
light and makeup are what create the sense of depth. Therefore, if your client
wants this look, you should encourage her to use a more heavy, evening type
of makeup. One caution, if your client has complexion problems, overex-
pose by a stop or so to blow out the imperfections. 

A simple variation on this look can be achieved using two small but dif-
fused lights illuminating the subject from the front. One should be placed a
foot or two above eye level, and the other can be positioned a foot or two
below it. For this type of lighting, I use a setup with two battery-operated,

FLATTERING FACES AND FIGURES 39

LEFT—Short lighting thins Bridget’s rounder
face to produce this gorgeous portrait. RIGHT—
Looking at this high-contrast portrait of Chan-
telle, you see how broad lighting can be really
attractive.



This image of Lauren was cre-
ated using a large overhead soft-
box. The white seamless paper
she’s posed on supplied the fill
light. The coy, over-the-shoulder
look and the implied topless pose
makes it a great teaser.

 



60-watt halogen video lights. These are mounted on a 4-foot bar with a han-
dle grip in the center so you can hold it with one hand and shoot with the
other (I had this made). The halogen light is a little bit cool, but if you set
your white balance to open shade you won’t even notice it. Make sure you
use the diffusers or the light will appear too hot and contrasty. 

Split Lighting. A less common but very dramatic technique is split light-
ing. Simply put, you literally split a face in two between light and shadow. I
don’t use this technique a lot because it can look shadowy, sinister, and dark.
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This outdoor image of Becky was shot using
the dual video-light method. 





In just the right glamour portrait, however, it can convey attitude. Another
situation where this might be useful would be in hiding a facial flaw.

FACIAL LIGHTING PATTERNS

In addition to the basic lighting strategies discussed above, I also use three
facial lighting patterns: loop, butterfly, and Rembrandt. All three have their
place, with loop lighting being my default style. Compared to talking about
scantily clothed, vivacious women, this may be sounding a little dry—but
bear with me. Your clients will love you for knowing this.

Loop Lighting. Loop lighting can be either short or broad. If you place
your main light at a 45-degree angle to your subject and slightly above eye
level, you’ll create a shadow on the opposite side of her nose. If it’s done
correctly, the shadow will form a semicircle that extends down to about
halfway between her nose and lip. 

Butterfly Lighting. To create butterfly lighting, start with your main
light in the loop-lighting position, then move it higher and toward the cen-
ter of the subject’s face—almost on axis with her nose. This pattern gets its
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FACING PAGE—This high contrast black &
white image of Shannon is about attitude—and
the split lighting emphasizes this. BELOW—
Miranda’s portrait shows that the loop-light
pattern can be applied at just about any angle.

 



name from the narrow shadow that you’ll see is cast just beneath the subject’s
nose—a shadow that looks like a butterfly. Made popular by Hollywood pho-
tographers, this pattern can be striking because of the way it highlights facial
features, emphasizing the eyes, cheekbones, and jawline, while deemphasiz-
ing the nose. (A lightbulb should have just lit up! This is one of the physical
features many women don’t like.) Moving your light slightly to the right or
left will determine whether your butterfly is short or broad.

Rembrandt Lighting. If you started with your main light in the loop po-
sition and moved about 20 degrees away from the camera and a little higher,
you’d have Rembrandt lighting. This pattern was made famous by one of
the great Renaissance painters, so you know it has to be good. 
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TOP LEFT—If you look past Shelly’s gorgeous
blond hair, you’ll see a classic butterfly (and
slightly short-lit) lighting pattern. ABOVE—
Note the classic butterfly shadow on Chepa’s
face. Remember this pattern when working
outside during midday; it’s easy to create.
LEFT—Rembrandt lighting narrows the face
and gives your image a classical look. Here,
you can see how this light draws attention to
Cheri’s eyes, cheekbones, and beautiful facial
structure.



You can also create this pattern by starting with a split-lighting setup
where you’re looking at the shadow side of the face. Then, move the light to-
ward the center until just a little light crosses the nose and creates a triangle
on the opposite cheekbone. Other than that cheekbone and the jaw, the en-
tire shadow side of the face will be quite dark.

Remember, faces come first. The previous section should give you a lot
of choices and a lot to think about. At first, your mind will probably be clut-
tered with the different options, but remember there is no single way to light
a subject. Usually you’ll have at least a couple of good options. But it’s al-
ways good to have a default to fall back. If in doubt, short light; if you’re de-
bating which pattern, loop light. You won’t go wrong.

FACIAL ANGLES

There are only three correct angles at which to photograph a face: full, two-
thirds, and profile. 

Full Face. In magazine photography, we see lots of full faces—but keep
in mind that they’re working with perfect faces and flawless makeup. 

You can create a full-face pose that is either basic or feminine. These vari-
ations used to be called masculine and feminine, but the industry has gotten
away from that. While it’s true that you will rarely light a man in a feminine
style, you often will light a woman’s face in a basic style. In a basic pose, the

For a basic full-face pose, the subject’s face
and body are facing the main light. In this
image of Fawn, you can see that her head is
then tipped toward her lower shoulder. 

 



subject’s body and face are both turned toward the main light. The head is
then tipped toward the lower shoulder. The degree of the head tip varies.
The subject’s body is turned away from the main light in the feminine pose
with the head turned back toward the light. The head is then tipped toward
the high shoulder and, again, the degree of the head tip varies.

Two-Thirds. For most people, a two-thirds view is generally most ap-
pealing because of its slimming effect. These poses can also be created in
both the basic and feminine styles.

Profiles. Profiles are a good variation, because they’re not often seen in
snapshots (and when they are, they are usually lit incorrectly, giving them a
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For a feminine pose, Missy’s face is turned
back into the light with her head tipped toward
her high shoulder.

LEFT—In the feminine pose, the eyes can con-
vey a defiant attitude, as Vicky is showing us.
Note that her body is turned away from the
light and her face back toward the light, which
in this case is the open, overcast sky. Her head
is tipped toward her high shoulder, making the
pose feminine. RIGHT—Leah’s body and head
are both facing the main light, making the pose
basic, while her eyes come back to make con-
tact with the camera. Her eyes, coming, back
across her nose toward the viewer, convey a lit-
tle coyness. Her head is tipped toward the
lower shoulder. 

 



police lineup look.) The main light should be placed at approximately a 120-
degree angle from the camera, facing toward the subject. From the position
of the subject’s face, the light is at a 45-degree angle on the side opposite the
camera. This means it is actually angling back toward the camera, so shade
your lens to prevent flare. Note the profiles can be done from either the front
or the back. 

FLATTERING FIGURES

We all intuitively understand body language, and when you’re posing a client
for a full- or three-quarter-length image, the pose sends a message almost as
important as the expression on her face. Good poses should flow and not
look strained and awkward. Early on in my career, I talked about this with
Monte Zucker. I mentioned that my clients don’t want to be posed; they
want to look candid and natural. “Bad posing looks posed,” was his response,
“good posing doesn’t look posed.” I’ve always remembered that.

Avoid Straight Lines. So how does that apply to glamour photography?
Our goal is to make a woman look feminine, alluring, and sexy. 

So, in terms of appearance, what makes men and women different? The
answer is curves! Men’s bodies are typified by straight lines and angles;
women’s bodies look feminine because of their curves and roundness. It fol-
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LEFT—Brittannie’s shoulders are at an angle
to the camera in this front profile. Notice how
the light—natural sunlight coming from her
right and back toward the camera. This is crit-
ical for an attractive profile. Also notice how
her head is tipped slightly away from the cam-
era, revealing more of her face. RIGHT—If we
look at the classic reverse profile of Tarina, you
see her head is actually tipped slightly away
from the camera. This gives the viewer a bet-
ter view of her face. Tipping the head toward
the camera will give you a view of the top of
the head and forehead, while blocking the eyes,
nose and mouth. Notice how the profile shows
off Tarina’s hair and how the upward gaze
gives her an angelic look. You can accentuate
this by tipping the camera.



lows, then, that you don’t want to make straight lines in the poses you cre-
ate for women’s portraits.

Our goal is to make or emphasize a classic hourglass shape for her upper
body and join this shape to long tapering legs. If you look at fashion maga-
zines, you’ll see that their models are almost never posed standing straight
up, with shoulders square to the camera. From this, I’ve developed what I call
the Rule of Twos. According to this rule, body parts that come in pairs
shouldn’t optically be on the same plane. This applies to the breasts (they’ll
do what the shoulders do), but also to the arms, hands, hips, legs, feet, eyes,
and ears. From this, it follows that the most unflattering thing you can do to
a female body is pose her straight up and down, feet shoulder-width apart,
and shoulders square to the camera. This creates straight lines, and that’s not
what we’re after.

The C Pose. There are basically two poses to flatter a female body: the
C and the S. Those of you who have art or dance backgrounds will already
know this. For everyone else, here goes. 

Poses start with the feet, and the subject’s feet should be at about a 45-
degree angle to the camera with her weight on the back foot. Her hip should
be kicked out slightly, as if she were carrying a baby in her arms. With her
weight on her back foot, her front foot (or “show foot”) will be free to swing

LEFT—Notice how the classic C pose in this
image emphasizes the curves of Shannon’s hips
and waist. RIGHT—Compare this image with
the one of Shannon. As you can see, it’s virtu-
ally the same pose—just a simple variation.
Athena’s left foot is kicked out and her arms
are raised.



in an arc a little less than 90 degrees. That foot will be placed in different po-
sitions along the arc depending on the look you want. 

At this point, her shoulders will also be at an angle to the camera. This
will make the far shoulder appear lower, because it is receding optically. You
can have her relax and drop that shoulder and/or raise the near shoulder for
emphasis. Having the subject tilt her head toward her high shoulder com-
pletes the classic C pose. 

The S Pose. The S pose is all about accentuating a woman’s curves. As
in the C pose, the subject’s weight is still on her back leg, but her front foot
is placed almost directly in front of the back foot (this doesn’t have to be
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The S pose is all about accentuating a woman’s
curves. 

 



exact). This forms the bottom portion of the female hourglass, narrowing the
appearance of the calves and accenting the curves of the model’s hips. The
subject’s back is then arched and her front shoul-
der is pulled down (you can simply tell your client
to pull her hip and shoulder together on the side
of her body closest to the camera). The combina-
tion of back, hip, and shoulder movement slims the waist, while the shoul-
ders then complete the hourglass. Finally, the head is tipped toward the high
shoulder, completing the S. This head tip generally projects some attitude;
the more pronounced the tip, the more the attitude. 

Both the C and the S pose can be either short or broad lit. If in doubt, I
suggest selecting a short-light setup. This means the light will skim across
most of her body rather than projecting directly onto it. When the light
crosses the body, the shadows created will accentuate the curves of her
breasts, hips, waist, and legs. 

This brings up another helpful principle that may seem a little counter-
intuitive. If you want to accentuate a feature, your light should cross it (short
lighting). Conversely, if you want to diminish a feature, project your light
directly into it (broad lighting). Remember, shape is revealed through shad-
ows, and short light creates more shadows (revealing more shape) while
broad light creates fewer shadows (revealing less shape).

This sounds like a lot of information, and if you’re new to all the talk
about posing and lighting, it may be a bit confusing. Still, if you study this
information, it will give you a great foundation. In time, these concepts will
become pretty automatic and you won’t need to do the mental calculus step-
by-step. If you have a good client or female friend you could practice on,
you could offer her free sessions. Another option is to test with a model, ex-
changing her modeling services for your images.

BE A POSTURE NAG

Just as poses start with the feet, posture starts with the back. I often tell my
clients that I want their bodies relaxed with the exception of their back. In-
struct your clients to keep their back tight. This doesn’t mean to stand ram-
rod straight. You’ll bend them a lot, just do it without slouching. With her
back erect, have her pull her shoulder blades together. “This will put the
Dollys and the J-Los in the right places,” as Robert Lino likes to say. Not only
that, it will elongate the neck, giving the body an attractive and graceful look.

SOLVING FIGURE PROBLEMS

When you’ve collected a number of women’s questionnaires, you’ll find the
same problem areas keep coming up. These would be: stomach, breasts, hips,
chin, nose, and legs. Often, things that a woman sees as a problem can be
overcome, hidden, or even—and this is when the job gets really fun—turned
into an asset. My favorite way to address a problem area is distraction, get-
ting the viewer to look at something else.
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When the light crosses the body, the shadows 
created will accentuate the female curves.

 



Waist. Let’s start with waists. “It’s really safe to say all women want their
waist thinner,” said Gayla. I won’t question that. I don’t really care what a
model’s waist actually measures, it needs to look thin. What most women
don’t realize is that “thin” is judged visually in comparison to the hips and
shoulders. Let’s say your client is posed with her body at a 45-degree angle
to the camera. If we turn her shoulders back toward the camera, the shoul-
ders appear wider. Her waist hasn’t changed, but it now appears thinner. To
accentuate this, turn her hips slightly toward the camera. Don’t do this, how-
ever, if your client has big hips or thinks her hips are too wide.

Stomach. Rachel (below) had just had a baby, so it’s not even realistic to
expect a flat, toned midsection for at least a year. In looking over her ques-
tionnaire, I noticed she thought she had a nice butt—and it was one of her

Rachel had just had a baby, so we chose a pose
that concealed her midsection and focused on
one of her favorite features—her bottom.



husband’s favorite features as well. For her portrait, we posed her with her
backside toward us, bringing her asset into the foreground and concealing
her tummy. We also kept her butt at a two-thirds view, a pose that is both
tasteful and slimming. Her arms were positioned to break up the line created
by her tummy and I chose the background color to blend the line as well. Fi-
nally, the Film Grain filter was applied in Photoshop to give the image tex-
ture. It also blurs the exposed portion of her tummy so you hardly notice it.

Let’s look at a second pose of Rachel (below). In this seated pose, con-
cealing the problematic stomach area is easy—just use a shapely thigh to
cover it. You’re not even aware of the problem, because you are looking at
something else. We used the same Film Grain filter to give the image an over-

In a seated pose, it’s easy to conceal the
tummy—a common problem area for many
women.



all softness. Note the other factors we’ve used to create a sexy, feminine look:
her curves are accentuated by the lean to her left, the main light is crossing
her body to produce nice shaping, and the lines made by her pose form a
gentle S curve.

Legs and Thighs. Legs and thighs too heavy? With the body at a 45-
degree angle to the camera and the shoulder turned a bit back toward the
camera, have your client take a small step toward you with her front foot.
Then, point that foot at you and bring its heel in line with the instep of her
back foot. You’ve now covered up at least half her back leg, optically slim-
ming them and completing the hourglass figure. For an example of this pose,
check out the portrait of Christal (above left).

Here’s another example. Kristal (above right) is short—about 5'2"—and
really cute. A common problem with shorter women is bigger hips and
thighs. To create a great portrait, we started with a fairly low camera angle
(aimed at her belly button). This optically lengthened her legs and mid-
section. Next, we put her right foot in front of her left, blocking your view
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LEFT—Christal has a great figure and this pose
accentuates it. Her back is erect and arched,
and her shoulders are back and turned slightly
toward the camera. Her front leg is extended
slightly and posed to obscure her back leg for
a slim, shapely appearance. RIGHT—This re-
fined S pose makes Kristal’s hourglass figure
the center of attention.



of half of her left thigh and, at the same time, giving us a nice tapered look
to her legs. I had her turn her left shoulder toward the camera, widening her
shoulders and, in proportion, slimming her waist and hips. I further slimmed
her hips by turning her left hip away from the camera. Arching her back and
tipping her right shoulder down put the curve in her waistline, completing
the hourglass.

Jenny, like Kristal, is short and has bigger hips (below). In this outdoor
pose, I started asking her to turn her right hip toward the camera. Since we
don’t see her left hip or leg, we don’t even think about their size. Out of
sight, out of mind. Next, I asked her to turn her left shoulder back to the
camera, widening her shoulders and proportionally slimming her waist and
hip. Because the light in the creek bottom was rather flat, I used a portable
flash with a diffuser as a main light, directing it into her hip to flatten it. The
shadow created on her hamstrings tends to slim her legs a bit, too. 

Here, the model’s pose and the shadows cre-
ated by the lighting are used to slim the look of
her hips and thighs.



Breasts. Large breasts sometimes sag. Brooke was concerned about this.
A lot of times photographing a subject in a bra (thank you Victoria’s Secret)
will help, but sometimes you’ll want a topless image. “Everyone likes them,”
Brooke, a regional rock singer, said. “But I’m really self-conscious about how
they look.” Still she wanted them in the image. In the sample image, I’ve
posed her on her back, contrary to advice some photographers will give. That
can be true if you don’t raise her arms, but raise her arms and her breasts fol-
low, resulting in a very sensual and glamorous portrait. An alternative could
have been supporting her breasts by folding her arms under her bustline,
which I would have done had I taken a bird’s-eye view (remember the movie
American Beauty). 

Some women are self-conscious about their small breasts. This can be ad-
dressed in two ways. First, you can divert the viewer’s attention to some other
part of the subject’s body. For instance, you can focus on the beautiful S-
shaped lines you create with her pose. You can also add something to her
surroundings—perhaps adding water sensually splashing over her body or
some other attention-getter.

Second, you can have your subject support her breasts by crossing her
arms over them. This gives the impression that she is coyly covering her
breasts. At the same time, though, her arms are doing the same thing as a
push-up bra. To finish, position the subject so the light is crossing her body,
creating a shadow in her cleavage. 
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For a subject with large breasts, lifting her
arms lifts the breasts, too. This creates a more
firm and shapely look.

 



THE CORRECTIVE MIND SET

In most of these examples, I’ve used
nude or seminude models as exam-
ples just to show you what can be
done using lighting, posing, and
ideas to compensate for perceived
flaws. Clothing and props give you
many more options. Just use your
imagination. Ask yourself questions.
What do I want to show? What don’t
I? And how can I use that to make
her look gorgeous? Here are a few
guidelines:

• If you want to diminish it, light
it directly.

• If you want to accentuate it,
light across it; create shadows.

• Call attention to a positive fea-
ture. Make it dramatic enough
that the viewer doesn’t notice
the “problem.”

• Create illusions. Use body
parts, clothing, or props to
break up unattractive lines.
When the mind sees an incom-
plete line, the imagination fills
it in. Imagination is much more
forgiving than reality.

• There is no substitute for a
beautiful, expressive face. There
are angles that flatter. Find
them.

• Learn to create body language.
This usually means bending and twisting that is exaggerated
beyond what your client would do in everyday life. The less
space your subject occupies in the image, the more exagger-
ated the pose needs to be. The opposite would be a head-
shot, where a glance back across the nose is very dramatic.

• Make sure the body language and facial expression agree.
• For women, body parts in pairs should not be posed on the

same optical plane. This creates curves. 
• Use different camera angles. Low angles lengthen legs and

torsos. High ones accentuate the face and foreshorten the
body.
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ABOVE—This shot has it all: a sensuous expression, a great
setting, and a flattering pose. The model’s arm supports her
breasts to create ample cleavage. This is then accentuated
by the side lighting. FACING PAGE—We painted Angel for
this image we did for a local radio station calendar. We
wanted the viewer to look at the playful expression on her
face, the fact she’s naked, and how much she seems to enjoy
teasing her viewers. Even though the main light is pointed
into her body, which actually tends to flatten breasts out,
that’s the last thing you think about. In looking at the rest
of the pose, note how we’ve created beautiful female curves
with her body. I placed her weight on her left leg and had her
pull that shoulder toward her left hip, creating the center
of the S, the beautiful arch in her back. Tipping her head to
her right completes the S. 





Y our approach to glamour photography remains the same
whether you are working in the studio, indoors, or out-
doors. Only your tools are different—and not all that much

different. The big difference is that, in the studio you’ll be more
in control of the backgrounds or sets; outdoors or on location, you travel
there to take advantage of a natural or specific background. 

If you’re a fan of elaborate sets, I may disappoint you. Because my goal
is to highlight my clients, the backgrounds used in my glamour portraits are

4. STUDIO AND INDOOR PHOTOGRAPHY

Angels do ride motorcycles, don’t they?



quite simple. They are meant to sup-
port the client’s image and the idea
behind her session, not to to be the
focus of the photograph.

BACKGROUNDS

Black Backgrounds. For complete
focus on the subject, it’s hard to beat
no background at all. I use black
quite a bit, and the secret to getting
it truly black (not muddy black) is to
keep light off of it. In theory, a back-
ground that receives five to six stops
less light than the subject will appear
black to the camera. Black seamless
paper works well, but it’s still a little
bit reflective, so you have to be care-
ful about stray light. You may want
to eliminate the fill light, since you’re
going for a contrasty look anyway.
Black felt is great at absorbing stray
light, as is velour. Many background
companies offer a light-absorbing
black material as well.

For a variation on the simple black
background, add some smoke from
a fog machine. Then, put a little light
into the smoke to make it show up.
In the image of Vicky (facing page),
we’ve used a strip light directly over-
head and slightly behind Vicky, mak-
ing it both the hair light and the
smoke light. 

Next let’s take the smoke and add
some gels to the light(s) to give the
smoke a color we like. Rita and I
wanted to create a Mardi Gras feel to
her portrait (next page), so I built
the background beginning with
black seamless and then applied
smoke from a fog machine. The
background lights were gelled in

vivid purple and orange. A strobe fitted with a 10-degree honeycomb lit
Rita’s face, leaving the fill to light the rest of her supple, barely covered body.
The masks and beads were added to support the theme.
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Notice how Brooke’s blond hair and tanned
skin tones jump off the black background. 





The black seamless set has yet another variation. This time (below) we
added flames for a real attention-getter. Shannon’s nickname is Bam. It’s her
alter ego—and Bam is a hottie, so why not flames? Where there’s smoke
there’s fire, so the background had to be hot—red and orange. Since I started
using fire as a special effect in pre-digital days, the fire here is actually real. I
learned this technique as a stage hand in college. Basically, I have different
shaped metal trays that hold lighter fluid, which we light just prior to the ex-
posure. You could do this digitally, but I choose to do it live. Nothing makes
an impression on a client like lighting your studio on fire! Naturally, this must
be done with extreme caution, far from any flammable materials and with
the safety of your client, yourself, and your staff in mind.

We did flames . . . how about water? Ever see Flash Dance? It took a lit-
tle work, but after we figured how to install a drain on the floor, the rest of
the set design fell into place. 

Tonya and I thought the shower idea would be absolutely erotic, and she
was game to create this dreamy, sensual image (next page, top). Again, you
see the now-familiar black seamless, this time paired with smoke lit by blue
gels. A 1x4-foot strip light illuminated the water falling on Tonya. Another
1x4-foot strip light was placed above and slightly behind Tonya, feathered
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FACING PAGE—For this Mardi Gras themed
portrait, the background is colorfully lit
smoke. I love the texture it gives. RIGHT—This
is one of my favorite images. We made it for a
potential CD cover, which is why the guitar was
selected as a prop. The band loved it at first,
but later decided it was too hot. Too bad. 

 



Even though Denise is lying on her back, the pose is
still an S. We’ve pulled her right shoulder and right
hip toward each other. This causes an arch in her
back right at her waistline. Raising her right knee
completes the S. If we wanted a more defiant atti-
tude, we could have tipped her head toward her left
shoulder. (Note: This is a really attractive nude pose
too. If Denise were nude, we’d have taken a slightly
lower camera angle and tipped her knee a little
more to keep too much female flesh out of the 
picture.)

Dana’s fiancé was a serviceman stationed overseas,
and she wanted to send him a gift while he was
away. We used a white seamless background, spread
sheets of mylar on the floor, and added gelled red
and blue lights on the background. A powerful
strobe projected the stars at about a stop hotter
than the background. A 3x4-foot bell-shaped soft-
box lit Dana. Note that Dana is in a C pose. The
camera angle is low to lengthen her body, because
she’s not tall—only about five feet. Further, we ex-
posed as much of her left leg as possible both to
lengthen her look and to tease a little bit.

Brooke is shown in a basic C pose. The wet hair
look, made popular by Calvin Klein ads, gives her a
really sexy look. The angle, shot over her back, is a
good variation. As with other poses, this shouldn’t
be shot straight on, but rather with the body at an
angle to the camera. There are two reasons. First,
you don’t want her tush to be too prominent. Sec-
ond, most people don’t have the flexibility to get a
decent facial angle with their back square to the
camera. Note Brooke’s two-thirds basic facial
angle. If she had to twist her neck excessively, the
pose would no longer look natural.

This pose requires strength in the back to keep the line straight or slightly arched—try it yourself. Not only is the back important, note the positioning of the feet
and legs. One foot, preferably the front one, is placed behind the other, raising that knee and partially hiding the other leg. Your subject must either wear heels
or raise her heels off the floor. Not all your clients will be able to pull it off, but for the ones who can, the lines of the body are absolutely gorgeous. 

 



slightly to light her body. A little of the blue background bleeds onto Tonya,
but that just adds to the mood. 

There are many variations to try with a simple black seamless background
set. For example, all sorts of translucent or patterned materials can be placed
between the background and subject. Your imagination is the only limit.

White Backgrounds. White seamless is just as versatile as the black. To
get that clean white look the background needs to be slightly overexposed—
about 11/2 to two stops over the main light falling on the subject. 

Let’s take the white seamless and add some mirrored mylar. I love using
this stuff; it’s like adding another extra-large softbox with a highly specular
quality. I picked a three-quarter length of Denise (facing page, bottom left)
to illustrate this. The specular quality of the mylar helps make her skin glow. 
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Sometimes just simple and white can be very
dramatic. It provides complete focus on the
subject, as in this fashion-style portrait of
Fawn. 

 



You can purchase rolls of the mylar from gardening supply or
packaging businesses. Its actual design use is for either hydroponic
gardening or gift wrapping. Although it comes in a wide variety of
colors, I mostly use the silver, because others give the skin a not-
always-pleasing color cast. A note about the mylar: although it is
highly reflective, you don’t want to use it for reflection images. It
distorts the reflection, giving you a circus funhouse effect. It’s easy
to end up with this type of reflection inadvertently. 

Gels and Secondary Backgrounds. Gels and secondary back-
grounds can be combined to come up with dramatic images, as in
the profile of Michelle (facing page, top). For secondary back-
grounds, we draped two large sections of fabric with different lev-
els of translucency. One we lit with a purple gel to match her
lingerie and the other we lit in orange, a complementary color. To
light Michelle, I used a strip softbox directly above and slightly be-
hind her, then angled it slightly ahead to give a pleasing profile
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LEFT—To backdrop Shannon’s leggy C pose, we started
with white seamless sweep and mylar on the floor. Then I
draped a sheer chiffon fabric as a secondary background
and added pink gels on the background lights to match her
lingerie. I lit Shannon with a 3x4-foot softbox to camera
left. As beautiful as this pose is, only use it on a thin, long-
legged subject. If your subject has heavy legs, it will make
them look heavier. If your subject has a little tummy, don’t
do this shot with a bare belly; use a flowing top that fits
loosely around the midsection. Expose or cover as much of
her hip and butt as needed to get the look you want.
RIGHT—For Jennifer’s image, a red-gelled light at one stop
below the main light was angled between the two back-
ground sections to give it a pinkish cast, similar to her out-
fit. A large softbox was used to light her, with a strip light
at one stop below the main positioned directly above her to
provide separation and highlights on her hair. Jennifer was
posed at a 45-degree angle to the camera with the main
light at almost 90 degrees to camera left. This gives a two-
thirds basic view of her face. Placing her right foot farther
ahead than the left leans her away from the camera and a
little arch in her back gives her great curves. Tulle fabric
was added to the floor for a feeling of softness.

 



light. The angle and lack of fill light put her near side in shadow, giving us
the beautiful semi-silhouette. 

Red Satin. There’s something really sexy about a woman in red. Look-
ing at Morgan’s image (bottom), I’m sure you’ll agree. The set is really quite
simple. We started out with a black seamless background, gelled red with
just a puff of smoke for texture. Under Morgan is a large red satin sheet. We
used the radio as a prop because of her job, and selected this pose because
she is known for her great legs. We added the blinds for the voyeuristic, teas-
ing effect they create. Morgan was lit with a large softbox to camera left and
a large strip light directly above and slightly behind her. This was angled
slightly ahead to put a subtle highlight on her body.

In this type of image, it’s important to pose the
subject’s legs so you can see light between her
knees. Otherwise, they will form a solid mass
and look heavy.

I created this image of Morgan, a sexy morn-
ing DJ, for a local “Women of Radio” charity
fundraising calendar. The committee rejected
her bare breasts as too hot for the calendar,
but Morgan and I love it. In fact, we sent it to
Playboy on pure speculation.



Remember the movie American Beauty? In it, the middle-aged character
played by Kevin Spacey lusts after his daughter’s girlfriend, played by Mena
Suvari. In a daydream, he imagines her nearly naked with red rose petals gen-
tly raining down on her. In the next couple years, I was deluged with re-
quests for this kind of image.

This image of Michelle (below) retains all of the fantasy, which is appar-
ently as attractive to women as it is to men. In the movie, the camera is from
directly overhead. To call attention to Michelle’s beautiful curves, I decided
to lower the camera angle a few feet and to move the camera to the right so
your eyes contact hers first. We used white petals for contrast. Michelle was
lit with a strobe fitted with a snoot that gives me about a 20-degree beam of
light with soft edges, causing the fall-off of light on her legs. There’s still
enough light to call attention to their length but not enough to take away 
attention from her face. A gelled strobe set 11/2 stops under the main light
illuminated the background of dark-red muslin. This had black tulle clothes-
pinned to it, rendering it a deep, subdued red that contrasts nicely with the
satin sheet she’s lying on. We raised her left knee to keep the focus from
going to her female parts.
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This image of Michelle retains all the fantasy
of the famous scene from American Beauty in
which Kevin Spacey’s character fantasized
about his daughter’s friend.

 



SPECIAL TECHNIQUES

Mirrors. Reflections can be really cool. Often, we get two views of the face
(and sometimes of the body) in the same image. Bear in mind a critical les-
son from Photography 101 when creating these portraits: the angle of inci-
dence equals the angle of reflection. When shooting on a mirror, it’s also
critical to make sure the mirror is rigid or is placed on a hard, flat surface.
Otherwise, the reflected image will be distorted.

Usually, but not always, I’ll use a white background as the starting point
for this set. That was the case in this image of Michelle (above). A second-
ary fabric background was then added and gelled to match her outfit. I se-
lected a low camera angle that was slightly above eye level to produce a full
view of her face in the main image and a two-thirds view in the reflected
image. Michelle is not large breasted, so the lower camera angle was also
helpful in giving her breasts more roundness (a higher angle would have
made them appear flatter). 

Window Light. Window light will produce some of the most beautiful
images you can create, and it’s remarkably easy to work with—just keep your
reflectors handy. Like shooting with hot lights, what you see is what you get.
It can be frustrating if you’re not used to it, because it doesn’t move. In-
stead, you must move your subject to get the correct angles.
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Michelle’s reflection image was lit with a large
softbox as the main light, placed to produce a
butterfly lighting pattern on the subject’s face.
A slight turn of the softbox to camera left
would have given us a loop pattern. A slow
shutter speed was used to pick up the candle-
light in the background.





The Wet Look. Using the wet look makes some of my most compelling
glamour images. Made popular by Calvin Klein advertising in the early- to
mid-’90s, it’s on it’s way to becoming a classic style because of its impact.
Note that straight hair doesn’t work as well for this style as curly hair. For that
matter, thin hair doesn’t work well either. Because it destroys any hairstyle a
client comes in with, you need to do this type of image exclusively or reserve
it for the end of a session. Also, I lean toward black & white for this style, al-
though I’ve found it can work in color as well. 

Let’s start with one of my favorite images of Shannon (next page). We
used fashion lighting, a large 3x4-foot softbox turned horizontally, placed
about two feet above eye level, and aimed down. While most fashion photog-
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FACING PAGE, TOP LEFT—This image of Tarina was
made in the window room of my studio. We have
her seated in a hammock swing with the main light
coming from the window on her left. The swing
was positioned in a corner with windows on both
sides, so the window behind her provides separa-
tion. The fill comes from a 6x3-foot reflector
feathered in from her right. FACING PAGE, TOP
RIGHT—Tia is positioned in just about the same
spot as Tarina (facing page, left), so the same
lighting conditions apply. The white walls and win-
dow frames of this room complement Tia’s white
lingerie. I chose the pose because it shows that a
basic pose can really be feminine. Her body and
her face are both turned toward the main light,
and her head is tipped toward the low shoulder.
Tipping her left hip up and pulling her left shoul-
der down, then bending her right knee and tipping
it in puts her body in a very feminine S pose. FAC-
ING PAGE, BOTTOM—Missy’s leggy, profile pose is
very similar to the purple and orange one we did
of Michelle when we were discussing white sweep
backgrounds (see page 65). Later in the day, the
light in this room comes from the west, over-
powering the north light that’s dominant the rest
of the day. Therefore, I positioned Missy perpendi-
cular to that west light to give her great profile
light. The bend in her legs, the arch in her back,
her closed eyes, and flowing white clothes give the
image its sensual feeling. As in Tia’s image (fac-
ing page, top right), the room’s colors comple-
mented the white outfit. A large muted silver
reflector was positioned just to the left of the cam-
era to soften the shadows. RIGHT—Window silhou-
ettes are really fun. We wanted to show off
Heather’s figure and create an image used for the
background of a calendar page. To create a silhou-
ette, you need to shoot from a relatively dark area
into a light one and expose for (or slightly under-
expose for) the light outside. Use no fill. In this
case, the light reading outside was f/11 at 1/60 sec-
ond with the camera set at ISO 100. I stopped
down one stop to f/16, posed Heather in the win-
dow, told her my neighbor had paid me to pose her
there (just kidding!), and took the picture.



raphers will place this dead center, I usually place it slightly to one side—in
Shannon’s case, to her right. This gave me a little bit of a short light, kind of
between a loop and a butterfly pattern. I used a reflector placed at about hip
level under and slightly ahead of the softbox to soften the shadows under
her chin, nose, and eyes—and to put catchlights in her eyes. Next, I placed
a large muted silver reflector to camera right to open up the shadows. Take
your reading and overexpose by one to two stops (depending on your cam-
era). You don’t want to blow out the skin, but you want to come close. 

High-Contrast Black & White. While I prefer Canon cameras, I use a
Fuji S1 for many of my high-contrast images. That was my first digital stu-
dio camera and was nothing short of a miracle when it came out in late 2000.
It’s now kind of a dinosaur in the digital world, but set on black & white with
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LEFT—To get the expression, you may have to
say the right thing. “I bet it’d look great to get
that top wet, too,” I joked. “Not so fast, pal,”
Shannon said, covering her breasts with her
arm. The first three words are the print’s title.
ABOVE—I love redheads, and Jessie has a great
look. While you don’t need color to identify a
curly-haired brunette with big brown eyes, I’d
have lost the penetrating blue eyes and that ex-
quisite red hair if I’d done the wet-look image
the way I usually do. To get this look, I said,
“Okay, just mess up your hair and shake your
head—but look at me when you’re doing it.” 



the maximum sharpness on, it produces a great high-contrast image. It holds
detail in the skin, even when overexposing by two stops—a situation where
I’ve had other cameras produce blotchy, blown-out white spots. The files
then take little or no postproduction adjustment, which is a real time saver.
Clients asking for this style have no expectations of a color image, so I don’t
consider it a drawback that I can’t use the file in color. 

More makeup is needed when shooting in this style. One of the positives
about high-contrast is that you will blow out the imperfections in the skin.
However, you don’t want to blow out important facial features like eyes, eye-
lashes, eyebrows (be really careful with blonds here), or lips. Because of that,
eyeliner, mascara, and lipstick are a must.
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When shooting in high-contrast black & white,
more dramatic makeup is needed—especially
with blonds like Vicky.

 



There are some backgrounds or sets that you simply can’t dupli-
cate in the studio, so you and your client will have to go on lo-
cation. Working on location can be a great creative experience,

but it also entails some challenges. We’ll look at the basics, then move on to
consider some specific examples.

LIGHTING

When working on location, my lighting setups tend to be simpler. In large
part, I try to use the natural lighting present. After all, the existing light is
part of the ambiance, part of why you went there in the first place.

Equipment. Other than my camera, my main tools on location are a
portable strobe and a couple reflectors. These reflectors can also be used as
gobos if needed. I virtually never use on-camera flash, because the straight-
on front lighting is flat and gives your image a snapshot look.
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5. GLAMOUR ON LOCATION

Working on location can be a great creative
experience, but it also entails some challenges. 



My preferred flash units are Vivitar 285 and Metz 45 series, both of which
I mount on a Redhawk stand that opens automatically when you set it down
on a hard surface. I know they’re both relics of the ’70s and ’80s, but since
I use them on manual, I don’t need advanced electronics. They’re also pretty

cheap, so when I lose one, it’s not a catastrophe—
and losing them is an occupational hazard, since I
use them near waterfalls, rivers, bridges, construc-
tion sites, etc. I must also note that not once in

over twenty years have I had a client look at an image and say, “Hey, you
used that cheap flash on this one!”

The beauty of this setup is that it allows you to put the light wherever you
need it. To trigger it, I use a radio slave. There are a lot of good ones on the
market, but I’ve had the best luck with the Quantum systems (I prefer the
4i). Like the flash units, they’re older, yet reliable. The slaves are basically an
on/off switch, so I don’t need sixty-four frequencies; sixteen will do. 

The Flash as Main Light. Understanding where your light is coming
from outdoors is just as important as in the studio. And, as in the studio,
you have different lights that perform different functions. More often than
not, I use the flash unit as a main light—but even it’s only one light, I’m re-
ally working with multiple sources. Under sunny conditions, for example,
we have three: the sunlight, the ambient (shade) light, and the flash. 

In bright sunshine, most women’s eyes can’t take the intensity of the sun
as a main light, resulting in a pained, squinty expression. In this situation,
most photographers head for shade. I don’t. I like to use the natural sunlight,
instead, as a separation light. To do this, I turn the subject’s back to the sun.
This  makes her hair look great, separates her from the background, and helps
her avoid squinting. You don’t need to get the sun directly behind her. That
causes flare, even with a lens shade. Instead, get it at an angle behind her.
Then place your flash on that same side, so the resulting main light—even
though it’s generated from flash unit—will look very natural. The ambient
light will be your fill. 

While I could use a reflector, and some will argue it’s more natural, in
bright sunlight, the reflector is almost as blinding as the sun. The human eye
is just not capable of reacting to the short duration of the electronic flash.

Flash Settings. To determine your flash setting, begin with the Sunny 16
Rule, a rule designed to provide a correct exposure when shooting in bright
sunlight. According to this rule, you should set your aperture to f/16, then
select the shutter speed that is the closest inverse of the ISO. For example,
at ISO 100, the closest shutter speed would be 1/125 second; at ISO 200, it
would be 1/250 second, and so on. 

So, let’s start by setting your ISO at 100. Based on the Sunny 16 Rule,
with our subject posed so that her back is to the sun, we know the separa-
tion light will be f/16 at 1/125 second. I prefer, however, to use a wider aper-
ture and the highest shutter speed I have available, usually 1/250 second. This
gives me f/11 at 1/250 second. 
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Losing flash units is a occupational hazard, since 
I use them near waterfalls, rivers, bridges, etc.

In bright sunshine, most women’s eyes can’t
take the intensity of the sun as a main light,
resulting in a pained, squinty expression.



Now, back to Photography 101. In this situation, your ambient (shade)
light level will typically be about two stops less or f/5.6 at 1/250 second. You
will want your flash main light to be about a stop higher to produce a high-
light and to create the correct lighting pattern on her face and body. If you’re
looking for a softer highlight (about a 2:1 ratio), you’ll want to get an f/5.6
out of your flash; that will give you an f/8 highlight. (Remember light is ad-
ditive, so f/5.6 plus f/5.6 gives you f/8.) If you’re looking for a more con-
trasty, more specular highlight, and deeper shadows, set your flash to get an
f/8 output—f/8 plus f/5.6 equals f/11. 

At first, you’ll probably need to take a few meter readings, but after a
while, you’ll have done it enough to know that at six to ten feet away from
the subject, your flash will give you f/5.6 at 1/16 power. If you need to place
it fifteen feet away (you don’t want it in the picture, after all), set it at 1/2

power.
A Trick for Reducing Flash Power. You’ll undoubtedly run into situ-

ations where your flash is too powerful, even at its lowest setting. When that
happens, use this neat trick from David Bently. A number of years ago, bare-
bulb lighting was all the rage. But what if you don’t have a flash that allows
you to take off the reflector or head? Bently described how he stapled wax
paper into a cone that he could just slip over the top of his Sunpak. This
works great. While I’m not interested in 360-degree lighting (nor do I have
enough battery power), I’ve found that the wax paper diffuser works just as
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Dana is a thirty-something fitness competitor.
In this image, I posed her with the sun at her
back, using it as a separation light. A portable
flash positioned 45 degrees to camera right
and about a foot above her eye level actually
supplied the main light. The flash was set to
equal the ambient shade light level to produce
a natural looking loop-light pattern on her
face. The low light ratio (2:1) prevents the
shadow areas on her face and body from block-
ing up.  



well when aimed in your subject’s direction. Tissue paper, napkins, or toilet
paper will even work in a pinch.

Positioning the Flash. You don’t have modeling lights on portable
flashes, so you have to approximate the placement, then check your LCD to
see if you have the right light pattern. This is a matter of learning by experi-
ence, but to obtain the default loop pattern, place the flash at about a 45-
degree angle to your subject’s face and about a foot above eye level. 

LOCATIONS

We all have different surroundings, and you’ll probably have different options
than I do. In the following examples, I’ll show you how I’ve applied the

techniques I just outlined. I’m sure it
will stimulate your imagination.

Tire Factory. In nearby Eau
Claire, WI, we have an old tire fac-
tory. Built between 1895 and 1940,
it’s got the perfect rust-belt am-
biance. The complex, which is only
partially used, has a number of alley-
like light tunnels, which give excel-
lent direction to the natural light.
This attitude shot of Tarina (left) was
done in one of them—a dead-end
alley behind one of the factory’s
giant smokestacks. 

Railroad Bridge. Near the tire
factory is an old railroad bridge that
once connected a shipping spur to
the factory. It’s now a pedestrian and
bike bridge. Jennifer and I had orig-
inally planned to make these street-
light shots black & white (next
page), but we later loved the
red/amber quality of the sodium
lights, and so decided not to convert
them. The factory is a visible, public
area, so nudity or seminudity is
pretty much out of the question.
Jennifer and I figured we could take
a chance on lingerie since it was
10PM. We were wrong. A passing 
bicyclist was apparently offended and
reported us—the police responded
quickly. The investigating officers
were good-humored about it and
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I posed Tarina in this doorway where the high
walls directed the light in from above and to
the camera right, just like a giant softbox. A
single 27-inch reflector was all I needed to
open up the shadows on her face.
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LEFT—We posed Jennifer directly under a streetlight and set the camera to ISO 1250. I first wanted her to look toward the camera with a lot of
attitude, but when I couldn’t get enough light into her eyes with the reflector (flash was out of the question here because it would be overpowering
and wouldn’t balance with the color of the streetlights), I told her to look up and past the streetlight. I love the dreamy, faraway look. It’s totally
different than what I had in mind, but sometimes that’s the creative process. RIGHT—The second image is more of a figure study with the same dreamy
look. We moved Jennifer slightly ahead of the streetlight to correctly light her profile and angled a 3x6-foot reflector back at her so the shadows
on her close side didn’t close up. When using this pose, it’s usually better to have your subject’s eyes closed. 

This image was made with natural light and just a kiss of light from a strobe at 1/16 power. This was placed just out of the picture to camera left and
kept the right side of her face from going dark. The S pose, her expression, and the background create a mood of defiance.



determined her outfit, although suggestive, didn’t violate public decency
standards. The incident did make the police blotter in the Eau Claire paper,
though.

Railroad Yard. Just about every city has a railroad yard and Altoona,
WI, is no exception. Parked in the rear of the yard is a tourist train, complete
with a steam locomotive and vintage passenger cars. Involved in a legal dis-
pute over track use, it goes nowhere, so my model and I decided not to waste
it. The image on the facing page (bottom) was made with natural light and
just a tiny bit of flash. The separation light was reflected off the aluminum

skin of the passenger car. We chose
the blue boxcar as a background be-
cause it complemented Heather’s
skin and because the graffiti matched
her attitude. 

Railroad Trestle. Teresa (left)
wanted a cool background to pose
with her prize possession: her Mus-
tang convertible. The railroad trestle
was it. Spanning an old millpond
near my studio in Fall Creek, WI, it’s
rusty steel, rivets and the diagonal
lines created by the bridge’s beams
makes a great backdrop for this leggy
pose. We timed the shot to take ad-
vantage of the last half hour of sun-
shine, to give the image the golden
hue. The image was made using only
natural light.

Rita (next page, top) is friends
with a couple of cops from an area
police department. She told them
she’d pose nude with their bike if
they’d let her use it for a local calen-
dar shoot. 

“It’s probably the best photo I’ve
ever had . . . and I’m naked,” Rita
said picking this image for her fea-
ture. The station decided to allow it
since the nudity was implied and, as
the station manager noted, “Techni-
cally she’s not naked; she has those
boots.” 

A large, muted silver reflector was
used to balance the hazy sunshine
and open up the shadows. The flash,
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Teresa had seen something like this in a Ford
ad and we thought having her pose topless
would make it even hotter. 

 



LEFT—The crossbeams made an in-
teresting background for this image.
Notice how Rita’s face is positioned
at the X. BELOW—Katie, a car en-
thusiast, poses with a couple of
1950s Buicks on their way back to
nature.  

positioned to camera left just out of the image, was used to put catchlights
into her eyes.

Junkyards. The junkyard is where the man-made backgrounds merge
with the natural ones. While most junkyards send older wrecks to the smelter,

 



I’m fortunate to have one that keeps a lot of older vehicles dating back to the
1930s.

In our first sample image from this site, Katie’s bent knee, the arch in her
back, and the tip of her head make the body pose an S (facing page, bot-
tom). Her facial angle is basic. As you can see, the sun behind and to her
right provided separation. A flash placed 45 degrees to camera right acted as
the main light and was responsible for bringing out her vivid blue eyes.

We chose the Oldsmobile Kortney is posing on (above, left) because of
the way the sunlight was streaming through an opening in the trees. This
light provided separation. The flash was positioned to camera left and raised
up high enough to give us a butterfly pattern on her face, which we turned
back toward the light. I had Kortney lean out of the bright light that
skimmed across her. This tilted her shoulders and set up the head tip. Rais-
ing her right foot created another diagonal and let her rest her elbows on her
knee. The result is a very natural-looking, curvy pose. 

The headshot of Angel (above, right) highlights her signature hairstyle.
The sunlight coming from high and almost directly behind her provides sep-
aration and highlights. The flash, placed high at camera left, matches the
sun’s intensity to give Angel’s face a butterfly lighting pattern. It also puts
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LEFT—Once I point out the lighting in this por-
trait of Kortney, you can see that the main light
is a strobe. It looks natural, though, and that’s
what your client wants. RIGHT—As you’ll no-
tice, this image of Angel was deliberately over-
exposed to provide flawless looking skin. 



pretty intense catchlights in her eyes. Some light was reflected off the truck
fender and chrome, providing a bit of fill. 

Tammy, a country singer, wanted to pose with the old cars for the liner
notes on her upcoming CD (below, left). An early 1950s Chevy Bel Air gave
her just the feeling she wanted. We had hoped to create the feeling of the
sun’s last rays, but the day we chose was pretty cloudy. Therefore, the flash
was placed to her left and slightly behind her to simulate the effect. My as-
sistant held a large 3x6-foot reflector to bounce some of the flash back to her
shadow side. While not perfect, it worked for the CD. She also ordered a
large print to hang in her home.

Lakes, Rivers, and Oceans. Some of you may live near oceans with beau-
tiful beaches. In my area, we have numerous lakes and rivers. Jennifer (below,
right) posed for this sexy and compelling portrait on one of the Eau Claire
River’s many sandbars. Shot at around sunset, the golden hues beautify her
skin and permeate the background. Jennifer’s facial angle is basic; her body
and face were turned toward the main light, a strobe balanced to match the
sunlight. Reflections off the water provided the fill light. 

While a lot of photographers avoid bright sunshine at midday, we took
Jess, who is a lifeguard and competitive swimmer, to another of the river’s

LEFT—We wanted a late-day look for Tammy’s
portrait, but the day of the session was quite
cloudy. As a result, we had to simulate the look
with flash. RIGHT—Jennifer is posed in a funky
C pose, necessitated by the sloping bank of the
river.

 



sandbars (above, left). Sandbars are great in that you can pose your subjects
in just an inch or two of water. Here, Jess’s facial angle is feminine; note the
marked head tilt toward her high shoulder. The main light was balanced to
match the reflected light coming off the water. Placed about 45 degrees to
camera right, it crosses her body and puts the catchlights in her eyes, the
sparkle in her teeth, and the highlight on her lips. Otherwise, her face would
have been quite shadowy. 

The wet-look image of Ilicia (above, right) is another attractive portrait,
and it was also shot at midday. Ilicia was posed hip-deep in the river, while I
stood on a boulder to get the high camera angle. This was important to the
image, because it gave her face command of the image. A lower camera angle
would have brought her wet top into prominence, but we wanted viewers to
notice her face first. The pose is a C with a basic facial angle. 

Waterfalls. There’s something very primal and comforting about clear
flowing water—and when you add a beautiful woman, there’s a sensual syn-
ergy that’s hard to describe. That’s why we’re going to take a look at a few
examples. The rapids along the Eau Claire River is one of my favorite settings
for glamour portraiture. At Big Falls, during low water conditions there are
a number of spots where it’s possible to pose clients in just a few inches of
moving water. 

The black & white image of Teresa (next page, top) is just such an exam-
ple. Because this location is in a deep canyon, sunset here is about an hour
earlier than elsewhere. This gives me quite a bit of sweet-light time to shoot.
In this case, though, we were past the golden hour and more into blue light,
so we decided to make a black & white image. It was shot with natural light
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LEFT—If an image is too tame, it won’t de-
mand attention, yet if it is too threatening, it
will turn viewers off. This kind of seminude,
based on my clients’ and viewers’ opinions,
strikes that balance. RIGHT—A flash, set to
match the intense sunlight, was set high and
about 40 degrees to camera right. This gave us
a bit of a short light and a narrow loop light-
ing pattern. The image was then slightly over-
exposed to give her complexion a flawless
appearance.





and one 30-inch silver reflector, placed about 60 degrees to camera left. This
wrapped light around her face and put catchlights in her eyes. 

Tonya’s pose (facing page, bottom) is very similar. The difference is that
her portrait was taken in midday light. The punchy noon sunshine gives the
water more sparkle, and Tonya’s expression has more attitude. The shadows
created by the overhead sunshine naturally cover up what might be too much
skin. To keep Tonya’s face from being too shadowy, we used a flash for a
main light. This was positioned about 75 degrees to camera right. The fill was
provided by light reflecting off the water. 

Janilee’s image was made on a hazy, almost cloudy summer afternoon,
producing very flat, even light (below). To put a believable highlight on her,

FACING PAGE, TOP—When prospective clients
see images like this in my slide show, they very
often want to pose nude. As in this portrait of
Teresa, however, I tend to avoid frontal nudity
in favor of poses like this. FACING PAGE, BOT-
TOM—Overhead light put shadows in just the
right places in this portrait of Tonya. RIGHT—
Janilee has a boyish figure, so it was essential
to have the light crossing her body. To create a
more curvy look, I had her raise her right knee
and lean her upper body toward it. Tipping her
head toward the high (opposite) shoulder com-
pleted the pose.



we used a flash, diffused with tissue, that was set to match the ambient day-
light as closely as possible. 

Normally fur coats and water don’t go together, but it was really cold
when Denise (above, left) posed for this image. This image was made with
natural light just after sunset with an assistant holding a 30-inch silver/gold
reflector to camera right, just out of the frame. 

Wildflowers. In July and August, prairie flowers grow in CRP fields
(agricultural fields being taken out of production by a federal subsidy), and
I make it a point to get the owner’s permission to photograph in these areas.
Maddeningly, while the plants grow year after year, they don’t flower as well
some years. So each year, I have to scope out new fields. 

Tammy, a regional country singer (above, right), was looking for an
image for a CD titled Fields of Love, so wildflowers were perfect. A high cam-
era angle was used to make her face prominent and to surround her with
flowers. Because it was a cloudy day, I placed a flash high and just to camera
left. This was paired with a reflector placed low and to camera right. This re-
duced the shadows from the flash and kept her jawline from blending into her
chest. The pose is a feminine C, and the facial angle is a feminine full face.
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LEFT—“I feel like a Siberian model,” Denise
said. “I really can’t believe I’m doing this.”
But after reviewing her images, she decided it
was worth it. RIGHT—Tammy, a country singer,
was looking for an image for a CD titled Fields
of Love, so wildflowers were perfect. 

 



W e’re in an era where technology has given photographers the
ability to do more with their images than ever before. If we’re
not careful, though, it’s possible to get so wrapped up in post-

production possibilities that our camera work gets sloppy. It’s easy to think,
“I’ll just fix this in Photoshop later.” I’ve been as guilty of doing that as the
next person. But think about it—is that why all this great software exists? So
we can patch up our mistakes? So we can get lazy?

Way back before digital photography, I was attending a workshop, hosted
and taught by Michele Gauger, of Whitewater, WI. “How much custom
printing do you need to do?” I asked her. “Almost none,” she answered.
“You need to get it right in the camera. You want it on the neg so you can
print it auto. You’ll never make any money at this if you can’t. I want to keep
that money instead of paying it to labs.” 

Even with today’s technology, this is still true. Your original camera files
should be saleable. This means composing correctly in the camera, being on
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6. DIGITAL TECHNIQUES AND ENHANCEMENTS

Photoshop is a great tool—an image presenta-
tion like this would be much more difficult
without it. It should not, however, become a
time-consuming crutch.

 



the money with your exposures, and making sure the backgrounds are free
from distracting elements. 

This may sound like an antitechnology rant, but nothing could be further
from the truth. I love Photoshop and other imaging software, but I want to
use that software to enhance already great images instead of trying to rescue
poor ones. 

CAMERAS AND LENSES

That being said, let’s review some cameras and lenses. (And, by the way, I
paid market price for all these cameras; neither Canon nor Fuji paid me to
plug their products.) 

As noted previously, a Fuji S1 was my first studio digital camera. While
it’s no longer one of my primary cameras, it’s my favorite for black & white—
especially high-contrast black & white. My two main studio cameras are
Canons—a 1Ds (the original 11.1-megapixel model) and a 5D. I love these
cameras, and the two most important attributes I believe they have are sharp-
ness and a full-frame (24x36mm) sensor. In various workshops, I’ve had the
chance to compare different brands and models of cameras and have not seen
any that top the Canons in terms of sharpness. There are a few that come
close and a lot that aren’t as sharp. 

I prefer a full-frame sensor camera because most lenses are designed for
a 24x36mm piece of film or sensor. Most digital 35mm-style cameras, how-
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This portrait of Janilee was shot with a Canon
70–200 f/2.8 lens set at 200mm at f/4.5. No-
tice how sharp Janilee’s face is, while every-
thing in front of and behind her is somewhat
soft. If you look toward the edges of the image,
you’ll notice that this effect is more pro-
nounced. If you own a smaller-sensor camera,
this effect isn’t impossible, it just requires
adding blur in postproduction. I prefer to do it
in the camera.



ever, use a sensor that is smaller than
that—meaning you’re not using the
full lens area that you are paying for.
As a result, all of your lenses become,
effectively, longer. Most cameras
with a smaller-than-35mm sensor
have a magnification factor of about
1.5. That means your normal 50mm
lens is effectively a 75mm. A com-
mon zoom lens like a 28–135mm is
effectively a 42–202mm. This is a
good thing if you want more tele-
photo out of your lens; it’s a bad
thing if you like wide angles. It’s a
good thing if you like a big depth of
field; it’s bad if you like it shallow.

Another thing that is not so ob-
vious is the fact that smaller-sensor
cameras do not use all the lens area.
The smaller sensors only use the cen-
ter of the lens. On the positive side,
this is the sharpest part of the image
formed by the lens, especially if you
are using a less expensive lens. If you
are using a good one, though, the
lens is designed to give you beautiful
fall-off of focus as you get toward the
edges of an image. With a smaller-
sensor camera, you’re not using this
natural vignetting. A quick glance at
Janilee’s portrait illustrates this effect
(facing page). 

What really sets lenses apart is not
focal length, though, it’s speed. My
favorite lens for glamour work is the

Canon 70–200mm f/2.8 IS. It’ll set you back about $1600. A lens with a
similar focal length in an f/4 to f/5.6 will cost you only $300 to $400, but
you’re giving up two full stops, which could make the difference between
shooting at 1/60 second and 1/15 second. Those are two stops you’d really like
to have when it’s getting dark on your shoot. The image stabilization (IS)
gives you about another stop, maybe two, if you’re handholding the lens. So
you see how much more the faster lens lets you do.

You’ve already seen examples from my tire-factory session with Jennifer,
but an extreme example of the advantage of fast lenses comes from the 
same shoot (next page). Shooting by street light only, I leaned on the bridge
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Angie’s image was taken as the sun was set-
ting. I was able to handhold the camera and
take the image f/2.8 at 1/40 second with the
camera set to ISO 100.



TOP LEFT—A fast lens can let you handhold your camera even in
low light. You could have taken this image with a slower lens
mounted on a tripod, but would your subject have stayed still long
enough? TOP RIGHT—Using a very wide angle lens let me capture
this attention-getting shot of Christal with a custom chopper. The
image was made for a bike shop, advertising their chopper line,
and for Christal’s modeling portfolio. ABOVE—The black & white
portrait of Hyun Joung on the couch is reminiscent of early photo-
graphs in that only her face is in focus. LEFT—Tarina’s portrait,
shot through the strands of a hammock chair, illustrates the same
principle; only her face is in focus. Both portraits were taken with
the Canon 85mm wide open at f/1.8.



rail and shot at 1/8 second at f/2.8 with the camera set at ISO 1250 and the
stabilizer on. The image is tack sharp and, yes, I was leaning against a solid
object—but otherwise this was handheld. 

The next lens on my list of favorites is a Canon 24–70mm f/2.8, which
I like for its low light capabilities. If I had to pare my camera bag down to
bare necessities, these two lenses would be the ones I’d chose.

If I could only have one more lens, it would be an extra-wide angle. The
one I currently use is a Tamron 17–35mm f/2.8–f/4. It’s particularly use-
ful when you want a lot of depth of field and an extra-wide field of view. 

Rounding out the lineup are a couple of lenses I use specifically for lim-
ited depth of field: a Canon 50mm f/1.4 and a Canon 85mm f/1.8. With
the lens wide open, you can practically shoot handheld in the dark, but their
best attribute is their limited depth of field. It’s so shallow that you can lit-
erally have a subject’s eyes in focus and their ear soft. What’s more, it often
reduces the backgrounds to textures or soft shapes, eliminating distractions
and forcing attention to the subject. 

DIGITAL ENHANCEMENTS

High-Contrast Black & White. By now, you know most of my techniques
start in the camera, and high-contrast black & white is no exception. The
key to getting the look you want is slight overexposure; too much, and you’ll
get patches of white with no detail, so it’s best to go a little easy. You can tell

how much to overexpose by testing a few images
in Photoshop. Open a test image and select the
Eyedropper tool. Move your tool over the image
and watch the Info palette. Sampling the bright-

est highlight you should get a value of not quite 255 (pure white). If you’re
in the 245 to 254 range, you’re right on the money.

My favorite camera for high-contrast black & white images, as I’ve said
before, is the Fuji S1. It has a black & white mode that produces an RGB file
with no color information. If you use one, set the sharpening and the tone
to hard. Then, overexpose by one to two stops. Your black & white files will
be ready to go right out of the camera.

If you are using a digital camera without a black & white function (or if
there’s any chance you might need a color file), shoot the image as I’ve de-
scribed above. After the shoot, you just have one more step: you’ll have to
convert your color files to black & white. My favorite method is the Lab
color method. 

1. Open your file in Photoshop. Go to Image > Mode > Lab color. 
2. In the Channels palette, select the lightness channel.
3. Go to Image > Mode > Grayscale.
4. Go to Image > Mode > RGB.

Now you have a black & white file with fairly high contrast and, if you’ve shot
the image properly, it may have the look you want with no more computer
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You can tell how much to overexpose by 
testing a few images in Photoshop.

To convert your color image to black & white,
switch to the Lab color mode, then click on the
lightness channel in the channels palette.



work. If the contrast isn’t quite there, go to Image > Adjustments > Curves.
Once opened, you’ll see a graph with a line running from the lower-left 
corner to the upper right. From the lower right go about a quarter of the way
up the line and click to set a point. Drag that point down slightly. The image
will get slightly darker. Next, go three-quarters of the way up the line and
click to set another point. Drag that one slightly up. You’ll see the whites
brighten. Experiment until you get the image looking the way you want it.
At first, you may want to use the Eyedropper tool to make sure you’re just
under 255. 

Enhancing the Eyes. Eyes are mysterious. They can be piercing, soft
and inviting, sexy, coy, or aloof. As the old saying goes, they are the windows
to the soul. They are also the most important feature of a face, so I want to
make them stand out as much as possible. The more tightly the image is
framed to a client’s face, the more important and noticeable the following
steps will be. 

In Photoshop, select the Lasso tool. Then, in the tool options, set a lit-
tle feathering. For most files, you’ll set this to about 20 pixels. You’ll use
more feathering for a close headshot, and less as you get more and more
body in the frame. Using the Lasso, select the eyes. Then, apply a little sharp-
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In the Curves palette, creating an S curve like
the one shown here will increase the contrast of
your image.

Ninety percent of the time, these images are
head-and-shoulders or tightly cropped head-
shots. However, this nude of Laura shows that
there are other ways of using the high-contrast
black & white effect.

 



ening with the Unsharp Mask filter. Using the sliders, I set the amount at 75
to 100 percent, the radius to 2.0 to 2.5 pixels and the threshold at 7 to 9 lev-
els (these settings will vary with the resolution of your file).

Next, choose the Burn tool. Set the range to shadows and the exposure
to about 4 to 7 percent. Zoom in close and, with a small brush, burn the dark
ring around the iris of her eyes. Then choose a smaller brush and draw a faint
line along the upper and lower eyelid (you’re putting on electronic eyeliner).
Finally, trace the outline of the more prominent eyelashes (electronic mas-
cara). Repeat for each eye.

To complete the eyes, choose the Dodge tool. Set the range to highlight
and the exposure at 6 to 10 percent. Choose a brush that will cover most of
the whites of her eye and gently dodge the whites to whiten them. Don’t
overdo this or she’ll look like an alien. Repeat for each eye. If your image is
a tight shot where the eyes are large in the frame, you can select the whites
with your Lasso tool and adjust the Curves to achieve the same effect.

If the subject of your image is a blond, you may also want to burn her
eyebrows a little. Depending on how light the brows are, you may need to
set the range on the Burn tool to midtones rather than shadows.

Enhancing the Lips. For her lips, choose the Brush tool. Set the opac-
ity at 75 to 90 percent (depending on her lip or lipstick color) and the flow
at 6 to 10 percent, then set the mode to color. Next, sample her lip color. Se-
lect a small, soft brush (about 1/8 the width of her lips) and trace the outline
of her lips, adding electronic lip liner. Then, enlarge your brush to the width
of her lips or slightly smaller. Lower your flow to 4 to 6 percent and reduce
the opacity to about 70 percent. Again, trace her lips to enhance their color
with electronic lipstick.
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The eyes were selected using the Lasso tool.

Here, we see the original image (left).the eyes
enhanced with the Burn tool (center), and the
finishing touches to the eyes made with the
Dodge tool (right).

Subtle enhancements in Photoshop make lips
look their best.



Enhancing the Teeth. Using the Lasso tool, with the feathering set at 5
to 10 pixels, outline her teeth. Then, go to Image > Adjustments > Curves.
Put a point on the center of the diagonal line and move it up slightly. Again,
don’t overdo this or she’ll look like an alien.

Enhancing the Skin. Lastly, you need to pay attention to her skin. First
take care of any blemishes or scars. This can be accomplished using either
the Clone Stamp tool or the Healing Brush. I prefer the Clone Stamp tool,
but that’s because I’m old school have been working with Photoshop since
version 2.0—and there was no Healing Brush back then. With whichever
tool you prefer, select a brush that is just slightly larger than the imperfection
you want to fix. Then, sample a clear skin area by pressing and holding
Opt/Alt and clicking with your mouse, and simply brush over the area you’d
like to fix.  

To smooth the skin, choose the Brush tool and set the flow and opacity
as you did to enhance the lips (see page 91). Press Opt/Alt and click to sam-
ple the skin tone in the area of her face you’d like to smooth. As you move
to different areas of her face, you’ll have to keep sampling her skin tone for
a natural look. Keep in mind that what you want to do is smooth the skin and
reduce wrinkles, lines, eye bags, etc. Less is more here. If you overdo it, your
subject won’t look natural. For instance, light shadows under eyes are natu-
ral, so blend and lighten them, don’t try to eliminate them. The same goes
for wrinkles. Look to take ten years off your subject’s age. If your client is
forty, don’t try to make her look eighteen—it won’t be believable.

Digital Glow. You could stop now. The image you have in front of you
is saleable. But let’s add a glow to her skin. 

1. Go to Layer > Duplicate Layer. 
2. Go to Filter > Distort > Diffuse Glow. In the dialog box that 

appears, play with the sliders to get just the look you want. 

3. Go to Edit > Fade Diffuse Glow. You’ll notice you have a number 
of mode options. My favorites are normal, hard light, and soft
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LEFT—The Diffuse Glow dialog box lets you
customize the effect of the filter. ABOVE—The
Fade dialog box lets you reduce or alter the ef-
fect of the Diffuse Glow filter.



light. You’ll want to experiment with these modes to get the look
you want. For further control, adjust the opacity of the effect. The
lower the opacity, the more of the original image will show
through. Again, you’ll have to experiment to find the look you
want. 

Porcelain Skin. To create an effect I call porcelain skin, I use Photoshop’s
blur filters. I often use digital glow and porcelain skin together, but you don’t
have to. 

1. Go to Layer > Duplicate Layer. 
2. Go to Filters> Diffuse Glow. Set the sliders as you like (I choose 

the following: grain—0 or 1; glow amount—8 to 10; clear 
amount—8 to 15).

3. Go to Fade > Diffuse Glow. From the mode drop-down menu, 
select Hard Light. Then, reduce the opacity to 70 percent (more 
or less is fine). 

4. Go to Filters > Blur > Smart Blur. In the dialog box, set the radius 
at 5 to 7, the threshold at 25, and the quality to medium. 
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ABOVE—Here’s a portrait of Ilicia. The inset is
the original; the large image has gone through
the Diffuse Glow process.

Smart Blur adds softness while trying to pre-
serve the sharpness of edges.



5. Go to the Layers palette and reduce the opacity of the duplicated 
layer. A setting of 50 to 80 percent usually works, but you’ll want 
to experiment a little. 

LucisArt. LucisArt is a Photoshop plug-in that can be purchased from Image
Content Technology or www.lucisart.com for about $170. It’s a cool effect

Here’s a portrait of Ivy. On the left is the orig-
inal image. Below is the image with the por-
celain skin effect applied. 



that can be used dramatically for a funky, artistic look. It can also be applied
subtly to enhance the texture of hair and clothing or the patterns of a back-
ground. I especially like to use it to create a surreal look in my high-contrast
black & white images. 

Proportional Enhancements. Good posing should always be used to
enhance a figure. But today, software gives us the tools to further enhance
and flatter our subjects. 

Back in the days before Photoshop 6, I used to painstakingly use the
Clone Stamp tool to shave a waistline. The addition of the Liquify filter, how-
ever, has made that technique obsolete. It gives you the ability to flatter a
woman’s figure like never before. In my opinion, the key to using the Liquify
filter successfully is to make your enhancements believable. I use good pos-
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You can see the finished look in this selective-
color image of Fawn. This image started out as
a “wet look,” high-contrast black & white that
could have been sold as-is. Comparing the orig-
inal (above) and finished (right) versions, you
can see how the LucisArt plug-in enhances the
texture of her hair beyond reality. The effect of
the sculpture mode was used at 100 percent,
while it was layer masked to only about 15 per-
cent on her skin. But to enhance the “wow”
factor, I added a little selective color in Photo-
shop, painting in her eyes their actual color at
25-percent opacity, and adding bright pink lip-
stick at 10-percent opacity.

 



ing to get the best-possible result right out of the camera, then use Liquify
to tweak it. I know several photographers who charge for and show clients
how they’ve enhanced their images. I believe my clients only need to know
they look great—and that I made them look that way.

Julie (below) had seen this pouty pose in a magazine and wanted one like
it. She has a little tummy, a young face (she’s only about 23), and terrific
breasts. She’s really proud of her assets and that’s the reason for the pose.
During the shoot, I instructed Julie to tighten her stomach and arch her back
a little. Then I selected a high camera angle to make her face, shoulders, and
breasts more prominent. After the shoot, I opened the image in Photoshop
and selected the Liquify filter (Filter > Liquify). In the full-screen dialog box
that appears for this function, I used the Warp tool to tuck in her tummy
just a little, shifting attention up to her breasts. With a much smaller brush,
I gently pushed in her lower back curve, optically slimming her waistline a bit
more. To finish the image, I added digital glow (see pages 92–93), almost
blowing out the line on her right upper arm, which slimmed that area a lit-
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Combined with careful posing and lighting,
subtle enhancements to a subject’s figure with
the Liquify function can create a flawless look.
In the original image (left), Julie has a little
tummy. In the final image, this area has been
gently smoothed (right).



tle. I also added yellow using the Color Balance adjustment (Image > Adjust-
ments > Color Balance) to warm her skin tone a bit.

In the Flash Dance–like image above, Tara looks great. Tara is athletic,
and the sports she trains in make her legs look a little heavy. I used the Liquify
filter to slim them. Since you can inadvertently distort body parts with this
tool, I used the Freeze brush to lock her left arm in place. Then, using the
Warp tool with a large brush, I gently squeezed her right thigh smaller. Most
of the pressure was applied to her tush and the back of her thigh.

Tara’s image was used for a local radio station calendar. It made her some-
what of a local celebrity. This image was part of a portfolio she bought con-
taining her favorite shots from the calendar session. Tara’s session was a
double or triple benefit to my studio. Not only did I get a sale, but the radio
station paid in trade for her session, so I got plenty of advertising value as
well. I’ll outline this in the next chapter.
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The athletic training Tara does makes her legs
look a little heavy (left). Using the Liquify tool,
I slimmed them slightly (right).



I f you want women to seek you out, you’ll need to first create an
image for your studio. This image should reflect your artistic style
and the work you produce. It could be a fun and relaxed image,

telling women to expect to have a great time. It could be a classy, upscale
image, where clients will come in expecting to really be pampered. It could
be anywhere in between—or something totally different. It’s up to you to de-
cide how to best appeal to the prospective clients in your market.

FOUR WORDS

For me, there are four words I want women to associate with my studio:
sexy, fun, classy, and discreet.

Sexy. I want women to know that we can create beautiful, alluring, mys-
terious, and sensual images of them. At my studio, we believe that you have
to please the woman first. We have to make im-
ages that will make our subject feel absolutely
wonderful about herself and how she appears.
This means really listening and often reading be-
tween the lines about what she considers sexy and how she feels about her
appearance. Even if the intended recipient of a portrait is the subject’s
boyfriend or husband, she must be happy with the results. And honestly, he’ll
be much easier to please than she is. 

Fun. The whole process should be fun—from the first phone call, to the
planning consultation, to the photography session, to building a finished
product from the images. “I couldn’t sleep last night,” Dee said. “I was just
thinking about how this would go—my makeup, if I had the right clothes,
having my hair done, you know.”

Classy. Face it, there are certain depictions of sexuality that women con-
sider—to put it mildly—distasteful. The worst thing for your studio would
be to develop a reputation for creating tasteless images. When you advertise
to glamour clients, people will inevitably try to characterize you as a pornog-
rapher. Unfortunately, there are people who are threatened or offended by
sexuality—and believe me, you’ll hear from them; they’ll be your loudest
critics. In almost all cases, though, these people wouldn’t be your clients any-
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7. MARKETING YOUR STUDIO

FACING PAGE—Dee set up a session to create a
wedding gift for her fiancé. This meant we had
to create images to please him, but that’s the
easy part—we also had to create images to
please her. 

There are four words I want women to associate
with my studio: sexy, fun, classy, and discreet.

 







way, even if your studio didn’t do glamour photography. The point is,
women want to be portrayed as beautiful—and sexy can be really beautiful. 

Discreet. Naturally, your clients need to be sure an intimate image won’t
turn up in a place where they don’t want it seen. I regularly use glamour im-
ages in my advertising and displays, but I need to use discretion in doing so.

To begin, I always get permission from the subject—and not just a model
release. By all means have a release, but go beyond that. Call or talk to your
client in person. Show her the image you plan to use and explain where and
when it will be used.  “I can’t believe you would use me!” Barb said when I
asked permission to use her image in my mall display. “I’ll tell my friends.
They won’t believe it.” She bought the print from me as soon as it came out
of the mall case.

Images that appear in your web site need to be approached in the same
way. Clients can be flattered to have their image featured, but since anyone
can access these photographs, you need to be careful.

Be conservative. You might be tempted to show your raciest images, but
it isn’t necessary. In almost all cases, don’t show nudity. If women are inter-
ested in glamour photography, sexy but clothed images will get the idea
across as well as the raciest nude. You also need to consider the audience.
Showing nude images would get me thrown out of the mall—and for good
reason considering the customers. 
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FACING PAGE—“I can’t believe you would use
me!” Barb said when I asked permission to use
her image in my mall display. ABOVE—“I
wanted something pure Hollywood, pure pin-
up,” said Vicki about a warm, rich image we
made for her modeling portfolio. “I just love
this.” The image makes her look like a 1940s
starlet, and it is considered sexy and artistic
by both men and women—especially women.
We made it in my studio’s brick room and lit
Vicki Hollywood style with an 18-inch fresnel.
Tungsten lighting added some warmth to the
background.





I don’t want my web site to be confused with a porn site, but here I can
be a little less conservative, since viewers go voluntarily to the site. Still, when
a nude appears, it’s most likely to be an implied nude—a teaser. In other
words, you won’t see any bare breasts or female parts.

Images used for brochures need the same web-site standard. Generally
speaking, prospective clients will have to ask for these materials, but you never
know where they’ll end up being passed along.

If you enter your prints in competition, feel free to use nudes, but make
sure you have permission beyond just a model release. You’d be amazed at
how flattered and how willing women will be to pose for you if the purpose
of the image is for a print competition. In fact, I’ve asked some glamour
clients back to pose for competition images, and rarely do they ask for pay-
ment, although I almost always give them the original print as a keepsake.
Make sure your nude competition prints are artistic. Judges come down
pretty harshly on nudes if they’re not.

MARKETING YOUR STUDIO 103

Whether it’s in print (facing page) or on your
web site (below), the images you select for your
ads should always be tasteful and designed to
appeal to women.



BE DIFFERENT

If you’ve read the 22,000 or so words that preceded this sentence, I’m sure
you’ve picked up on this idea. But here it is again: If there are other studios
doing glamour photography in your market, figure out what they’re doing
and do something different. Just make sure it’s creative and classy.

Throughout the ’90s, I was stunned at the business the national glamour-
shot studios did and frustrated that I couldn’t attract the same clientele to a
better product and service. Not only that, I knew I could offer them a bet-
ter price—or at least a better value. I had a number of women from these na-
tional studios tell me that their “glamour shots” didn’t even look like them! 

I’m sure it’s true. In our area of northwestern Wisconsin, the glamour-
shot studios ran a traveling road show with no permanent studio. They
showed up two or three times a year, setting up in a hotel suite or empty
mall storefront, did the extra-heavy makeup application, big hairstyles, and
(in my opinion) cheesy clothing. Still, these road shows packed the women
in—baiting them with cheap session fees, then following up with high-
pressure sales techniques and overpriced packages. I hated it, because even
when I did get women in for a session, they expected the same sales tactics.
This wasn’t me. I want clients to buy my work because they love it.

Fortunately, the glamour-shot approach wasn’t what most women really
wanted either. They wanted to look like them-
selves—really good, but still like themselves.
That’s when the light went on: we would make
women look like the most beautiful possible ver-
sion of themselves! My studio immediately started doing consultations, the
idea of which was to find out each client’s vision of herself and set up a ses-
sion to try and bring that vision to life. I gave away a bunch of free sessions
to create advertising images that would actually show off this concept. That
was the birth of my glamour portrait photography business.

CREATING DEMAND FOR YOUR BRAND OF GLAMOUR

So how do you create a demand for what your studio is capable of making?
There are four methods: media trades, displays, web sites, and referrals. These
combine to create an image of a creative studio and provide an ongoing
source of sessions.

Media Trades. I suggest doing a local calendar—shoot two or three for
that matter. Look for radio stations, or possibly groups of bars or car and
motorcycle clubs, as prospects. Radio stations have great promotional abili-
ties and, I believe, will make your best prospects.

My favorite calendar was created to prove that Wisconsin women are in
fact a lot better looking than popularly held stereotypes. To dispel the com-
mon misconceptions, a local radio station organizes bikini contests in which
winners are chosen for the twelve calendar months. The calendars are sold lo-
cally. Many of my prospects know or recognize some of the calendar girls
and think, “If he can make her look great, I need to go to his studio.”
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FACING PAGE—The radio station sold the April
2006 page to a local Polaris dealership and we
agreed to use one of their Victory motorcycles
as a prop. The result was this image—and new
relationships built between my studio, the Po-
laris dealer, and most importantly Vicky. I
helped broker a deal where Vicky appeared as
a celebrity at the dealership’s sales events. Of
course, Vicky continually needs new images to
update her portfolio, so I have a beautiful,
eager model when I need one.

Radio stations have great promotional abilities and,
I believe, will make your best prospects.





Guys are the target audience, but don’t think their wives and girlfriends
don’t know which images their guys appreciate. Calendars show off your tal-
ent and create the perception that yours is a cutting-edge, creative glamour
studio. Since it’s a visual resume, make sure only your best work goes in it.
Insist that you have some input into the layout so it makes your work look
its best.

For the past five years, I’ve done the photography for a radio station cal-
endar. No money changes hands; it’s all a trade. The station gives me dollar
for dollar in advertising time, but indirectly I get much more advertising
than that. The DJs call these promotional mentions, and they’re worth a lot. 
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The photo for Roxy’s page in the 2006 calen-
dar is pure pin-up, and it’s one of my favorites.
A local car club volunteered the ’76 Corvette
she posed with, and Roxy bought the sexy
swimsuit to match the color of the car. 

 



In addition, I get several on-air interviews in which I’m free to mix in pro-
motional information with the low-down on the calendar shoots. During
some interviews, we have call-in contests where we give away glamour and
calendar sessions. 

Often, we book more than just the winners. “I really wanted to win that
calendar,” Tonya said after narrowly losing the call-in contest. “I think it
would be so cool. I’d still like to book a session, even if I have to pay for it.”
I offered her 25 percent off as a consolation prize, and I’ve done glamour ses-
sions for her every year since. I’ve also entered two images of her in national
competitions, and they have earned merits each time.

The radio station calendar has been great exposure and every year it has
added to my reputation as the glamour studio in my area. It generates new
business relationships with the sponsors, and many of the calendar girls will
also become long-term clients who buy images, recommend my services, and
become a ready source of models.

Displays. Show off your work wherever and whenever you get the
chance. The displays that work best for my glamour work appear in malls, hair
salons, custom motorcycle shops, custom car shops, limousine companies,
and a few clubs. You can also look at your web site as a display, but since it’s
such a big one, we’ll give it its own classification. 

Among the displays mentioned above, the mall location has the most traf-
fic. For several years, I was afraid to pay the kind of rent the mall office asked
for (it’s more than my mortgage!), but starting up the display has been one
of the best advertising and marketing moves I’ve ever made. It works so well

that I devote every January’s display to glamour
photography as a lead up to Valentine’s Day. For
the past five years, as soon as the holiday rush is
over, my staff and I pick out the coolest glamour

images, galleries, and montages, and devote the entire display to glamour
photography—a shrine to femininity. (For more on my Valentine’s Day spe-
cial, see pages 112–15.)

Be very careful what images you pick. Carefully examine the image’s mes-
sage. If in doubt, leave it out or save it for another venue. And be prepared—
you will get complaints—and the people complaining will always raise more
of a fuss than the people who appreciate your display. When this first hap-
pened to me, I was crushed. I considered my work really artistic. Yes, the
images were sexy, but that was the point. Yet, here I was being called a
pornographer, an exploiter of women! 

One of the images that critics complained about was of a calendar girl, a
lead singer for a well-known local rock band (next page). Brooke was posed
in a black bikini, lying on a black plexiglass mirror and wrapped in chains—
something she does for her stage act. 

“We’re getting too many complaints,” said Jan, the mall’s leasing man-
ager. “Can you take the girl in chains down?” I agreed; I value my relation-
ship with the mall management.
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Starting up the display has been one of the best 
advertising and marketing moves I’ve ever made. 



As I was taking Brooke out and substituting another image, the manager
of a nearby clothing store approached me. “You can’t take Brooke,” he said
emphatically. I told him about the complaints and explained that the office
had asked me to take her out. “The complaints didn’t come from me or any-
one who works here,” he said. “We all love her.” The next time I stopped at
the mall office, the leasing manager informed me that the clothing manager
had organized an informal poll of store employees and clients and that
Brooke’s fans outnumbered her critics by ten to one! Over time, I’ve found
that people who appreciate my images far outnumber those who are of-
fended. But count on your critics to make more noise. 

Here’s another story that underscores the success of my displays in at-
tracting glamour clients. Krissa (facing page) came to the studio as a direct
result of what she saw at the mall—it just took her about a year to do it!

“I saw the photo of Denise in your display,” Krissa said. “It was really
well done and I’d like something like hers.”

“Denise was in the display last January,” I said. “This is December.” 
“I know, but I always thought it was really cool, and our anniversary is

coming up in March. I thought I could give that to Curt,” she said. “That
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When displayed in a mall, this image drew
strong criticism—but even stronger support!



and I’m going to be thirty-three. I think now is really a good time for me to
do this.”

She was in for a consultation the next week. The lesson is this: don’t 
underestimate the value of the impression your advertising makes, and don’t
always expect immediate response.

Web Site. If I had only one advertising venue, I’d have a web site. Most
of my glamour sessions start as an information request in my e-mail box.

I devote an entire gallery, called simply “The Women’s Gallery,” to glam-
our photography. When prospective clients visit the web site, they first see a
primer explaining the studio’s glamour philosophy, as well as our most pop-
ular glamour products. This gets them thinking about the types of images
they would like to create and what kind of products they’d like to make.
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My mall display made such an impression on
Krissa that she was still thinking about it al-
most a year later.  She came in to do a session
for an anniversary present.

 



From there they can choose to look at an image gallery where the differ-
ent styles of images are displayed. As noted in chapter 1, these are: artistic,
classic beauty, fashion, pin-up, provocative, and sensual. They can also choose
to watch these in a slide show presentation. The slide show probably has a
greater impact, but the gallery allows viewers to linger over images, enlarge
each shot, and study it. 

Since viewing the web site is voluntary, you can include racier images and
show more skin than you would in a mall display. Still, I err on the side of
caution and include almost no frontal nudity. I might include bare breasts or
an implied nude, but only if it’s a very artistic image. 

The web site also includes vignettes of each month’s calendar girl from
the radio station calendar. These get more hits than virtually anything else on
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“Wow, I didn’t think I could look that good,”
Kristal said. “Thanks for making me beauti-
ful.” The truth is, she looks pretty darn good—
but the images we created exceeded her self
image. Further, she really put a lot of herself
into the session. 



my web site. During the calendar shoot we make way more images than can
be used in the calendar. With an eager audience, why not show them more?
Since these are all local young women, it serves as a great testimonial to the
quality of my work. I believe a lot of women think, “If she can do it and look
that good, why not me?” (Note: Web surfers can also access the monthly vi-
gnettes from the radio station’s web site, so I have inserted a couple of land-
ing slides that make it clear they have come to the Fall Creek Portrait Design
web site and that we are the area’s glamour specialists. Another slide shows
how viewers can create their own personal calendars.)

Referrals. The calendar generates quite a bit of interest, but you should
never underestimate the value of client referrals. Let me give you a couple 
examples. 

Kristal (facing page) is the wife of an army reservist who was stationed in
Iraq for most of 2005. To surprise him, Krystal decided to send him Christ-
mas cards with glamour images inside. “I really miss him and want to do
something special for him,” she said. We did a session with a Christmas
theme, chose her favorite images, and for ten days she sent him a card con-
taining a different image of her—and he absolutely loved them.

During the next couple months, a number of military wives called to
book sessions—some from as far away as 250 miles. It wasn’t until I got into
a couple of sessions that I learned that their husbands were all from Krystal’s
husband’s unit!
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Beth (above) and Melanie (whose military-
themed image we saw on page 33) came in for
sessions after their husbands saw images I had
created of the wife of another soldier in their
unit.



“My husband said that one of his friends got pictures of his wife recently,”
said Dana. “He said he’d really like to have some of me—and he thought you
took the ones of his buddy’s wife.”

“Is his name Doug and hers Kristal?” I asked. 
“Curvy short girl with a Courtney Cox haircut?” Dana asked. “If you

did those Christmas cards, you have a lot of admirers in the 454th!”
Within a month, Melanie, Beth, and Jackie all scheduled sessions. I also

photographed Dana, who I knew from photographing her wedding a few
years earlier, but she was the only one of the wives from the 454th that I
knew before the shoot—the rest were all new clients gained through the re-
ferral from Kristal’s husband.  

In chapter 1, we looked at images of Fawn, Elizabeth, and Laura—all
medical techs from a prominent clinic. The three women did their sessions
together, booking a half day of my studio time. The referrals that resulted
from this session weren’t as fast paced as the military ones, but within a year
I had photographed a half dozen other women who worked at the clinic, as
well as some of their friends.

Special Events. Creating a special event can be a good way to get peo-
ple excited about your work—and to encourage them to book a session ei-
ther now or in the future.

For example, since 1997, I have run a Valentine’s Day promotion every
January. I originally expected nothing more than to boost cash flow in an
otherwise slow month. What I didn’t realize at the time was that most
women wouldn’t respond to the event directly; instead, I was building a last-
ing impression as to the type and quality of my glamour work. Now I run the
event with the intention of building my brand recognition and reputation
rather than booking a month’s worth of glamour sessions.

While I try to improve the promotion every year, I think I’ve come up
with a cost-effective, month-long advertising campaign that creates a lasting
impression. As noted on pages 107–9, the centerpiece of this is my mall dis-
play. In my market area of about a quarter million (I know that, to some of
you, this is small), we have one dominant mall. In
fact, an entire retail community covering several
square miles has grown up with Oakwood Mall at
its center. It draws traffic from probably a hundred
miles in each direction, making it perfect to display my work. 

For five weeks, from January 1 to the first weekend in February, my dis-
play in the mall is devoted to glamour photography. The rest of the year,
glamour is a minor part of the display. I decorate the 8x12x10-foot kiosk
with fifteen to twenty large, framed portraits—all depicting different photo-
graphic styles and subjects. Again, relying on just a model release is not suf-
ficient for this usage; make sure your subjects know ahead of time that their
images will appear in the display. 

To support the larger images, we’ll also include smaller galleries, a few 
session books, a glamour album (propped up on a red Valentine’s Day candy

112 MASTER GUIDE FOR GLAMOUR PHOTOGRAPHY

I’ve come up with a cost-effective advertising 
campaign that creates a lasting impression.



box), and possibly a calendar or two. We finish off the whole display with
some props—stockings, high heels, not-too-racy lingerie, and maybe a few
feather boas. 

Last year, we also added a flat-screen iMac computer that plays a looped
slide show, so we can show off even more glamour images. The slide show
holds an audience better than I ever thought it would.

Both at the kiosk and other locations around the mall we put up POP
(point of purchase) signs announcing our event. The signs should show a
variety of photographic styles, especially the styles you’re most excited about. 

When you plan a special event like this, the information on your web site
should reinforce what potential clients see at the mall. In our case, a flyer an-
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For promotional materials, you should select
images that are sexy but not too racy.

 



nouncing the Valentine’s Day specials appears in both our upcoming events
section as well as right after the landing page in the women’s gallery. A
slightly different version of the slide show is run at this time of year. As al-
ways, the information-request and consultation-scheduling forms are easily
available. 

The final step is radio. I have quite a bit of trade available from the cal-
endar project (see page 106), so I usually save one of my on-air interviews
to announce this special. Last year, we ran a contest for a calendar session and
had women call in and tell us why they should win. The best answer, as
judged by myself and the DJs won. All the finalists were given half-price
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Remember, your signs need to attract women,
so select images that almost any woman could
see herself creating—and loving.



glamour sessions. During the breaks, I get to talk about the calendar shoots,
glamour photography, and all the cool products we can make with our im-
ages. Then, I directed prospective clients to the web site or the mall display.

In addition, I run about three weeks of commercial spots. Here are two
sample scripts:

Sample 1
This Valentine’s Day, give your guy something that can only come
from you: a special collection of photos of you from Fall Creek Por-
trait. You can even put them in a calendar. This boudoir photo session
with award-winning photographer Chris Nelson can make you look
beautiful all twelve months of the year. Make your appointment early
by calling Fall Creek Portrait Design at 877-2695 or 1-800-262-5019.
Or check out their award-winning portraits at the kiosk near J. C. Pen-
ney in Oakwood Mall. You can also visit www.FallCreekPhoto.com.

Sample 2
Girls, this is your chance. Take advantage of Fall Creek Portrait De-
sign’s once-a-year glamour event. Just in time for Valentine’s Day,
glamour sessions are 25 percent off. You’ll be photographed by Chris

Nelson—you’ve seen his work on our calendar.
Just what do you do with those fabulously sexy
images? Make a twelve-month calendar or one
of our new calendar posters. Or maybe your

own centerfold poster (nudity not required, but cute, sexy smiles are).
Or keep the whole experience with a session book or make a portfo-
lio from your favorites. And you might just give one or two to your
guy. You know he doesn’t already have one. Consultations encour-
aged. Call for yours today—800-262-5019. Or see our display at Oak-
wood, or check us out online at www.FallCreekPhoto.com.
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“This Valentine’s Day, give your guy something 
that can only come from you . . .”



W e could use this [image] for the center spread of your book,”
I said to Angel as we posed her for her image on the green vel-
veteen background.

“Ever since I saw that in American Beauty, I always wanted something
like this,” she said, “but I’m a yellow rose kind of girl.”

Click. “You’ve got to see this,” I said, climbing down from the steplad-
der. I knew we’d nailed the image. The pose, expression, lighting, and back-
ground weren’t going to get any better.

I turned the camera around to show her. “Wow . . . yes. That’s it,” she
said. The sale was made right there. Even though she’d later see the image
projected on an eight-foot screen, the two-inch LCD image confirmed it to
us both. In that one moment, I reinforced her desire to purchase the prod-
uct I’d be selling her at the end of the process. It was actually the culmina-
tion of the sale.

PLAN FOR SUCCESS, BUT BE OPEN TO INSPIRATION

Of course, the sales process had actually begun a couple months earlier at her
consultation. Since we’re in a commissioned art business, it’s important to
understand our client’s desires and needs ahead of
time. After all, you can’t spend hours creating im-
ages in hopes you’ll stumble across something
your client likes. It’s equally nonproductive to fin-
ish a great session, show your client her images, and only then begin pre-
senting the product options. This isn’t to say that every glamour session goes
according to a rigidly determined plan. Instead, the consultation usually sets
up a flexible outline with a final product in mind. Depending on how well
the session goes, we often go beyond that. 

A recent session is a great example. Renae (facing page) had been chosen
for this year’s radio station calendar. At her consultation, she said she wasn’t
really interested in doing anything more than her calendar features and did-
n’t really want to buy anything beyond the few images she got as part of the
radio station gift package.
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8. SALES BEGINS BEFORE THE SESSION

You can’t spend hours creating images in hopes
you’ll stumble across something your client likes.



In the time between Renae’s consultation and her session, the radio sta-
tion DJs and I set the schedule and assigned Renae to March. When she ar-
rived for her session, I told her she was Miss March. “Oh wow!” she
exclaimed. “I love basketball—March madness.” 

I didn’t have a school or professional court available, so I suggested using
the court at the park for a street basketball look. “I’ve got a bunch of [Wis-
consin] Badger clothes,” she said. “And I can bring a basketball.” Armed
with our new concept, we completely scrapped the earlier plan. Renae went
home to get her Badger clothes. We got to the park, set up on the court, and
made some sexy basketball images. 

The calendar image turned out to be something really special because
she was so excited about the idea. She bought a session book, a gallery, and
several enlargements—way more than she had ever intended.
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When Renae, a basketball fan, learned she was
to be Miss March, she was very excited.

 



Most sessions are more carefully planned than that, but there are often
surprises—and the best images are often arrived at on the way to the origi-
nal primary goal. A lot of these surprises don’t reveal themselves until the
screening presentation.

PROJECTION SCREENING FOR THE “WOW” FACTOR

“I can’t believe I look that good!” said Janelle after seeing the images from
the session she had just completed twenty minutes earlier. “I just want them
all.” That’s the “wow” factor. When a client reacts like that, you can charge
just about anything you want. 

I project all my sessions using slide show programs. I call these sessions
screenings, and I usually conduct them immediately after the shoot. Today,
this is standard for not just glamour but virtually all types of photography.
After all, there’s nothing wrong with immediate gratification. Post-shoot
screenings enhance your sales, because the excitement of the session is still
intense. Naturally, you want to take advantage of that with a really impres-
sive presentation.
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A screening presentation right after the session
can help boost sales by capitalizing on the ex-
citement of the shoot.



To do this, I use a private screening and sales room. This features a 10-
foot screen bordered by heavy drapes that look like old-fashioned stage cur-
tains. Wall portraits and galleries in various sizes grace the walls. Speakers for
a quality sound system are recessed in the walls. The projector is mounted
near the ceiling and aimed slightly downward to minimize distractions, like
people walking through.

Choose a projector that is bright, at least 1250 lumens, and has good
color reproduction. This is a lot easier than it was a few years back, but it’s
still a good idea to try it out first. Exact calibration with your monitor, espe-
cially if your monitor is an LCD like most laptops, can be troublesome. Since
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A good composition can be viewed from any
angle—as you can see from this image of
Janilee. A glamour session was something
she’d never done, and she thought it would be
fun.  She was one of six women working at the
same medical clinic who all did sessions. They
referred one another.

 



there is no expectation for an exact color match, in this case, close is good
enough.

We’ve used several programs to do our slide shows—Graphic Converter,
iView Media Pro, Pro Select (from Australia), and iPhoto. 

Currently, we’re using iPhoto because of its ability to rapidly import im-
ages from a session, quickly tweak exposures and color, do black & white or
sepia conversions, then run them as a slide show. It also seamlessly accesses
our iTunes library (or clients’ CDs). We can also edit the images and then ex-
port them to a folder for processing in Photoshop—all in about ten minutes
for a sixty-image session.

Pro Select, while it is a little slower in preparing the slide show and has
fewer slide transitions, does allow for exact sizing for wall portraits. You can
also organize and rank images according to the client’s preferences, then
print out itemized order sheets and invoices.
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Jessica, a member of a volunteer fire depart-
ment, did this image for a local radio station
calendar. Although the image wasn’t selected
for the final calendar, it was chosen to deco-
rate the firehouse meeting room!



I find creating glamour images personally rewarding. There’s some-
thing really artistically satisfying, sexy, and cool about creating sty-
listic and sensual images that describe what makes a particular

woman alluring and feminine. Glamour clients are also among the most ap-
preciative you’ll ever photograph, which is a great reward in and of itself.

Still, it would be misleading of me to suggest that glamour photography
is a no-fail way to get rich. At my studio, weddings still produce the biggest
tickets, while high-school senior sessions are the most profitable. The typi-
cal glamour client, on the other hand, is in her twenties and probably at least
a little strapped for cash. 

But think about what this means. Some time in the near future, your
glamour client will very likely get married. Since she has a great relationship
with you and your studio, you’ll probably book her wedding. You’ll meet
her fiancé, if you haven’t already, to shoot their engagement session. She may
even want another glamour session for a wedding gift—I often even throw
these in for free. 
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Glamour clients like Roxanne are among the
most appreciative you’ll ever photograph,
which is a great reward in and of itself.

 



After that, she’ll get pregnant. That’s a milestone that requires artistic
documentation. After her child is born, she’ll want photos of the newborn.
Soon, she’ll be calling for her first family session—and there will be one every
five years or so after that. And, of course, she’ll probably have more kids. 

While she might have been strapped for cash at twenty-two or twenty-
three, guess who’s making a lot of the two-income decisions now? Soon, ex-
pect another glamour session just to reaffirm that she still looks good after
having kids. 

You get the idea. That glamour session can actually turn into a twenty-
year (or longer) business relationship—and, let’s face it, the opportunity for
a new and lasting friendship. A glamour session that inspires trust and makes
your client feel good about herself is a great entry point into someone’s life.

For her 2007 calendar theme, Rita chose out-
door sports—here, hunting and fishing. Rita
has done a calendar session in each of the last
four years. I wish I had more clients like her.
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gels, coloring with, 64–65
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Calendars, 21–23
Centerfold posters, 23
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Clients, understanding, 19–37
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Digital enhancements, 89–97
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high-contrast black & white, 
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skin, enhancing, 92–93
skin, porcelain, 93–94

Digital photography, 85–89
Discretion, 101–3
Displays, 107–9
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Eyes, enhancing, 90–91
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Fabric, 32–33
Facial angles, 45–47

full face, 45
profile, 46–47
two-thirds view, 46
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Figure problems, solving, 50, 
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Glamour portraits, defined, 10
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Hair, 30–31
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fashion, 39–41
loop, 43
outdoor, 72–75
Rembrandt, 44–45
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Lips, enhancing, 91
Location photography, see 
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Makeup, 30–31
Mall displays, 107–9
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creating demand, 104–15
displays, 107–9
importance of being different, 
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referrals, 111–12
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Nudes, 34–37

O

Outdoor photography, 72–84
equipment, 72–73
flash techniques, 73–75
locations, 75–84

P

Pin-up style, 14–15
Posing, 47–56

breasts, 55
corrective, 56
C pose, 48–49
legs, 53–54
posture, 50
S pose, 49–50
stomach, 50–53
straight lines, avoiding, 47–48
waist, 50

Presenting images, 118–20
Products, 21–29
Provocative style, 17–18

Q

Questionnaire, self-rating, 20

R

Radio ads, 115
Referrals, 111–12
Retouching techniques, see

Digital enhancements

S

Sales techniques, 116–20
Seminudes, 34–37
Sensual style, 16–18
Session books, 25–26
Silhouettes, 67
Skin, 92–94

enhancing, 92–93
porcelain, 93–94

Stomach, 50–53
Studio atmosphere, 29–30, 98–103
Studio photography, 58–71
Styles, 11–17

artistic, 14
classic beauty, 11–12

(Styles, cont’d)
fashion, 13
pinup, 14–15
provocative, 17–18
sensual, 16–17

T

Touching the subject, 37

V

Valentine’s Day event, 112–15

W

Waist, slimming, 50
Web site, 109–11
Wedding gift, 8
Wet look, 69–70
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BLACK & WHITE MODEL
PHOTOGRAPHY
Bill Lemon
Create dramatic, sensual images of nude and lingerie
models. Explore lighting, setting, equipment use,
posing, and composition with the author’s dis-
cussion of sixty unique images. $29.95 list, 81⁄2x11,
128p, 60 b&w photos and illustrations, index, order
no. 1577.

OUTDOOR AND 
LOCATION PORTRAIT
PHOTOGRAPHY, 2nd Ed.

Jeff Smith
Learn to work with natural light, select locations,
and make clients look their best. Packed with step-
by-step discussions and illustrations to help you
shoot like a pro! $29.95 list, 81⁄2x11, 128p, 80 color
photos, index, order no. 1632.

WEDDING PHOTOGRAPHY
CREATIVE TECHNIQUES FOR LIGHTING,
POSING,AND MARKETING, 3rd Ed.

Rick Ferro
Creative techniques for lighting and posing wed-
ding portraits that will set your work apart from the
competition. Covers every phase of wedding
photography. $29.95 list, 81⁄2x11, 128p, 125 color
photos, index, order no. 1649.

POSING AND LIGHTING
TECHNIQUES FOR STUDIO
PHOTOGRAPHERS
J. J.Allen
Master the skills you need to create beautiful
lighting for portraits. Posing techniques for
flattering, classic images help turn every portrait
into a work of art. $29.95 list, 81⁄2x11, 120p, 125
color photos, order no. 1697.

CORRECTIVE LIGHTING,
POSING & RETOUCHING FOR
DIGITAL PORTRAIT PHOTOGRAPHERS, 2nd Ed.

Jeff Smith
Learn to make every client look his or her best by
using lighting and posing to conceal real or
imagined flaws—from baldness, to acne, to figure
flaws. $34.95 list, 81⁄2x11, 120p, 150 color photos,
order no. 1711.

CLASSIC NUDE
PHOTOGRAPHY
Peter Gowland and Alice Gowland
Gowland offers technical and practical advice from
fifty years of experience. Fully illustrated, this book
is a visual tribute to one of the most prolific and
highly regarded photographers in the genre of
nude photography. $29.95 list, 81⁄2x11, 128p, 60
duotone photos, order no. 1710.

PORTRAIT PHOTOGRAPHER’S
HANDBOOK, 2nd Ed.

Bill Hurter
Bill Hurter has compiled a step-by-step guide to
portraiture that easily leads the reader through all
phases of portrait photography. This book will be
an asset to experienced photographers and be-
ginners alike. $29.95 list, 81⁄2x11, 128p, 175 color
photos, order no. 1708.

PROFESSIONAL SECRETS OF

NUDE & BEAUTY PHOTOGRAPHY
Bill Lemon 
Learn the technical aspects of composition and
posing as well as how to ensure the comfort of your
nude models. For photographers of all levels.
$29.95 list, 81⁄2x11, 128p, 60 b&w photos, order
no. 1713.

MASTER POSING GUIDE FOR
PORTRAIT PHOTOGRAPHERS
J. D.Wacker
Learn the techniques you need to pose single
portrait subjects, couples, and groups for studio or
location portraits. Includes techniques for photo-
graphing weddings, teams, children, special events,
and much more. $29.95 list, 81⁄2x11, 128p, 80
photos, order no. 1722.

PROFESSIONAL TECHNIQUES FOR
DIGITAL WEDDING
PHOTOGRAPHY, 2nd Ed.

Jeff Hawkins and Kathleen Hawkins
From selecting equipment, to marketing, to
building a digital workflow, this book teaches how
to make digital work for you. $34.95 list, 81⁄2x11,
128p, 85 color images, order no. 1735.

OTHER BOOKS FROM

Amherst Media®



LIGHTING TECHNIQUES FOR
HIGH KEY PORTRAIT
PHOTOGRAPHY
Norman Phillips
Learn to meet the challenges of high key portrait
photography and produce images your clients
will adore. $29.95 list, 81⁄2x11, 128p, 100 color
photos, order no. 1736.

PHOTOGRAPHER’S 
LIGHTING HANDBOOK
Lou Jacobs Jr.
Think you need a room full of expensive lighting
equipment to get great shots? With a few simple
techniques and basic equipment, you can
produce the images you desire. $29.95 list,
81⁄2x11, 128p, 130 color photos, order no. 1737.

PROFESSIONAL 
DIGITAL PHOTOGRAPHY
Dave Montizambert
From monitor calibration, to color balancing, to
creating advanced artistic effects, this book
provides those skilled in basic digital imaging
with the techniques they need to take their
photography to the next level. $29.95 list,
81⁄2x11, 128p, 120 color photos, order no. 1739.

GROUP PORTRAIT
PHOTOGRAPHY HANDBOOK,
2nd Ed.

Bill Hurter
Featuring over 100 images by top photog-
raphers, this book offers practical techniques for
composing, lighting, and posing group
portraits—whether in the studio or on location.
$34.95 list, 81⁄2x11, 128p, 120 color photos,
order no. 1740.

LIGHTING AND EXPOSURE TECHNIQUES
FOR
OUTDOOR AND LOCATION
PORTRAIT PHOTOGRAPHY
J. J.Allen
Meet the challenges of changing light and
complex settings with techniques that help you
achieve great images every time. $34.95 list,
81⁄2x11, 128p, 150 color photos, order no. 1741.

THE ART OF BLACK & WHITE
PORTRAIT PHOTOGRAPHY
Oscar Lozoya
Learn how master photographer Oscar Lozoya
uses unique sets and engaging poses to create
black & white portraits that are infused with
drama. Includes lighting strategies, special shoot-
ing techniques, and more. $29.95 list, 81⁄2x11,
128p, 100 duotone photos, order no. 1746.

THE BEST OF WEDDING
PHOTOGRAPHY, 2nd Ed.

Bill Hurter
Learn how the top wedding photographers in the
industry transform special moments into lasting
romantic treasures with the posing, lighting,
album design, and customer service pointers
found in this book. $34.95 list, 81⁄2x11, 128p,
150 color photos, order no. 1747.

SUCCESS IN 
PORTRAIT PHOTOGRAPHY
Jeff Smith
Many photographers realize too late that camera
skills alone do not ensure success. This book will
teach photographers how to run savvy marketing
campaigns, attract clients, and provide top-notch
customer service. $29.95 list, 81⁄2x11, 128p, 100
color photos, order no. 1748.

PROFESSIONAL STRATEGIES
AND TECHNIQUES FOR 
DIGITAL PHOTOGRAPHERS
Bob Coates
Learn how professionals—from portrait artists to
commercial specialists—enhance their images
with digital techniques. $29.95 list, 81⁄2x11, 128p,
130 color photos, index, order no. 1772.

LIGHTING TECHNIQUES FOR

LOW KEY PORTRAIT
PHOTOGRAPHY
Norman Phillips
Learn to create the dark tones and dramatic
lighting that typify this classic portrait style.
$29.95 list, 81⁄2x11, 128p, 100 color photos,
index, order no. 1773.

THE BEST OF WEDDING
PHOTOJOURNALISM
Bill Hurter
Learn how top professionals capture these fleeting
moments of laughter, tears, and romance.
Features images from over twenty renowned
wedding photographers. $29.95 list, 81⁄2x11,
128p, 150 color photos, index, order no. 1774.

THE DIGITAL DARKROOM
GUIDE WITH ADOBE®

PHOTOSHOP®

Maurice Hamilton
Bring the skills and control of the photographic
darkroom to your desktop with this complete
manual. $29.95 list, 81⁄2x11, 128p, 140 color
images, index, order no. 1775.



BIG BUCKS SELLING YOUR
PHOTOGRAPHY, 3rd Ed.

Cliff Hollenbeck
Build a new business or revitalize an existing one
with the comprehensive tips in this popular book.
Includes twenty forms you can use for invoicing
clients, collections, follow-ups, and more. $17.95
list, 81⁄2x11, 144p, resources, business forms,
order no. 1177.

PORTRAIT PHOTOGRAPHY
THE ART OF SEEING LIGHT

Don Blair with Peter Skinner
Learn to harness the best light both in studio and
on location, and get the secrets behind the
magical portraiture captured by this legendary
photographer. $29.95 list, 81⁄2x11, 128p, 100
color photos, index, order no. 1783.

PLUG-INS FOR ADOBE®

PHOTOSHOP®

A GUIDE FOR PHOTOGRAPHERS

Jack and Sue Drafahl
Supercharge your creativity and mastery over your
photography with Photoshop and the tools
outlined in this book.  $29.95 list, 81⁄2x11, 128p,
175 color photos, index, order no. 1781.

POWER MARKETING FOR
WEDDING AND PORTRAIT
PHOTOGRAPHERS
Mitche Graf
Set your business apart and create clients for life
with this comprehensive guide to achieving your
professional goals. $29.95 list, 81⁄2x11, 128p, 100
color images, index, order no. 1788.

BEGINNER’S GUIDE TO
PHOTOGRAPHIC LIGHTING
Don Marr
Create high-impact photographs of any subject
with Marr’s simple techniques. From edgy and
dynamic to subdued and natural, this book will
show you how to get the myriad effects you’re
after. $29.95 list, 81⁄2x11, 128p, 150 color photos,
index, order no. 1785.

POSING FOR PORTRAIT
PHOTOGRAPHY
A HEAD-TO-TOE GUIDE

Jeff Smith
Author Jeff Smith teaches surefire techniques for
fine-tuning every aspect of the pose for the most
flattering results. $29.95 list, 81⁄2x11, 128p, 150
color photos, index, order no. 1786.

PROFESSIONAL 
MODEL PORTFOLIOS
A STEP-BY-STEP GUIDE FOR PHOTOGRAPHERS

Billy Pegram
Learn how to create dazzling portfolios that will
get your clients noticed—and hired! $29.95 list,
81⁄2x11, 128p, 100 color images, index, order no.
1789.

THE PORTRAIT PHOTOGRAPHER’S
GUIDE TO POSING
Bill Hurter
Posing can make or break an image. Now you can
get the posing tips and techniques that have
propelled the finest portrait photographers in the
industry to the top. $29.95 list, 81⁄2x11, 128p,
200 color photos, index, order no. 1779.

MASTER LIGHTING GUIDE 
FOR PORTRAIT PHOTOGRAPHERS

Christopher Grey
Efficiently light executive and model portraits,
high and low key images, and more. Master
traditional lighting styles and use creative modi-
fications that will maximize your results. $29.95
list, 81⁄2x11, 128p, 300 color photos,  index, order
no. 1778.

LIGHTING TECHNIQUES FOR

FASHION AND GLAMOUR
PHOTOGRAPHY
Stephen A. Dantzig, PsyD.
In fashion and glamour photography, light is the
key to producing images with impact. With these
techniques, you’ll be primed for success! $29.95
list, 81⁄2x11, 128p, over 200 color images, index,
order no. 1795.

WEDDING AND PORTRAIT
PHOTOGRAPHERS’ 
LEGAL HANDBOOK
N. Phillips and C. Nudo, Esq.
Don’t leave yourself exposed! Sample forms and
practical discussions help you protect yourself and
your business. $29.95 list, 81⁄2x11, 128p, 25
sample forms, index, order no. 1796.

PROFITABLE PORTRAITS
THE PHOTOGRAPHER’S GUIDE TO
CREATING PORTRAITS THAT SELL

Jeff Smith
Learn how to design images that are precisely
tailored to your clients’ tastes—portraits that will
practically sell themselves! $29.95 list, 81⁄2x11,
128p, 100 color photos, index, order no. 1797.



Creating flattering glamour portraits of real women
requires three basic skills: a style that flatters femi-

nine faces and figures, interpersonal skills to percep-
tively work with female clients, and a solid marketing
plan. In this book, you’ll learn all this and more, giving

you a solid footing for building a glamour photography
business or adding glamour photography services to an
existing studio’s product line.

FEATURES:
Understanding each client’s unique needs and how to
create portraits she will love

Developing lighting and posing strategies that minimize
problem areas and accentuate assets

Creative ideas for indoor and studio shots—from 
complete sets to simple window-light portraits

Taking glamour portraits on location, including tips for 
location selection and lighting

Digital techniques for enhancing images after the shoot

Marketing and sales techniques to create a demand for
your brand of glamour photography
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